KODAK ESP 3.2 and 3.2s
All-in-One Printers

Extended User Guide
## Table of contents

1 **Printer Overview**
   - Components .......................................................................................................................... 1
   - Control panel .......................................................................................................................... 2
   - Using the LCD touch screen .................................................................................................. 3
     - Home Screen Menu ............................................................................................................. 3
     - Home Screen Status Icons ............................................................................................... 4
   - Home Center Software .......................................................................................................... 6
   - Ordering supplies .................................................................................................................. 7
   - Configuring printer settings ................................................................................................. 8

2 **Networking Your Printer**
   - Connecting to a wireless network .......................................................................................... 9
     - Before you connect ............................................................................................................ 9
   - Connecting to a wireless network using the Wi-Fi Setup Wizard ......................................... 10
   - Setting up an IP Address ....................................................................................................... 13
   - Viewing the network configuration ....................................................................................... 14
   - Printing the network configuration ...................................................................................... 14
   - Installing your printer on additional computers on the network ....................................... 15
   - Connecting to another KODAK All-in-One Printer ............................................................ 15
   - Adding a wireless network connection to a USB-connected computer ............................. 16
   - Changing from USB to a wireless connection ....................................................................... 16
   - Connecting with Wi-Fi Direct™ .......................................................................................... 17
     - Enabling and Using Wi-Fi Direct ....................................................................................... 18
     - Connecting and Using Wi-Fi Direct for a Mobile Device or Computer with WPS .......... 19
     - Viewing your Wi-Fi Direct Network Configuration ........................................................... 20
     - Changing Wi-Fi Direct Settings ....................................................................................... 20
   - Connecting to another KODAK All-in-One Printer ............................................................ 15
   - Editing the settings for KODAK Email Print Service ............................................................ 39
   - Registering your printer with Google Cloud Print™ and KODAK Email Print Service ........ 38
   - Editing a Google Cloud Print™ Account ............................................................................. 39
   - Editing the settings for KODAK Email Print Service ............................................................ 39

3 **Online Printer Management Tool**
   - Accessing the Online Printer Management Tool ............................................................... 22
   - Using the Online Printer Management Tool ........................................................................ 23
     - Configuring printer settings ............................................................................................... 23
     - Changing the printer name ............................................................................................... 24
     - Setting up Scan To Email .................................................................................................. 24
     - Setting up Scan To Network Folder .................................................................................. 31
     - Changing printer settings for copying and printing ......................................................... 35
   - Setting up Cloud Printing .................................................................................................... 38
     - Registering your printer with Google Cloud Print™ and KODAK Email Print Service .... 38
   - Editing a Google Cloud Print™ Account ............................................................................. 39
   - Editing the settings for KODAK Email Print Service ............................................................ 39

4 **Handling Paper**
   - Paper types ........................................................................................................................... 41
   - Paper sizes ............................................................................................................................ 42
   - Envelope sizes ...................................................................................................................... 43
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loading paper</td>
<td>43</td>
</tr>
<tr>
<td>Loading plain paper</td>
<td>43</td>
</tr>
<tr>
<td>Loading photo paper</td>
<td>46</td>
</tr>
<tr>
<td>Loading envelopes</td>
<td>48</td>
</tr>
<tr>
<td><strong>5 Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Printing documents</td>
<td>50</td>
</tr>
<tr>
<td>- Printing two-sided documents</td>
<td>50</td>
</tr>
<tr>
<td>- Printing forms from the control panel</td>
<td>51</td>
</tr>
<tr>
<td>Printing pictures from a memory card</td>
<td>52</td>
</tr>
<tr>
<td>- Viewing pictures on a memory card</td>
<td>52</td>
</tr>
<tr>
<td>- Using default settings to print a picture</td>
<td>53</td>
</tr>
<tr>
<td>- Changing the settings and printing pictures</td>
<td>54</td>
</tr>
<tr>
<td>- Printing panoramic pictures</td>
<td>56</td>
</tr>
<tr>
<td>- Printing tagged pictures</td>
<td>57</td>
</tr>
<tr>
<td>- Zooming and cropping pictures</td>
<td>58</td>
</tr>
<tr>
<td>Printing pictures from a wireless device</td>
<td>59</td>
</tr>
<tr>
<td>Transferring pictures to a computer</td>
<td>59</td>
</tr>
<tr>
<td>- Transferring pictures to a computer with WINDOWS OS</td>
<td>59</td>
</tr>
<tr>
<td>- Transferring pictures to a computer with MAC OS</td>
<td>59</td>
</tr>
<tr>
<td>Printing picture collages using KODAK Photo Collage Print App</td>
<td>60</td>
</tr>
<tr>
<td><strong>6 Mobile Printing</strong></td>
<td></td>
</tr>
<tr>
<td>Printing using Google Cloud Print</td>
<td>61</td>
</tr>
<tr>
<td>Printing using KODAK Email Print Service</td>
<td>62</td>
</tr>
<tr>
<td>- Printing emails, documents, and pictures</td>
<td>62</td>
</tr>
<tr>
<td>Printing from a mobile device</td>
<td>63</td>
</tr>
<tr>
<td>- Printing pictures from an iPhone, iPad, or iPod Touch device</td>
<td>63</td>
</tr>
<tr>
<td>- Printing pictures from a BLACKBERRY Device</td>
<td>63</td>
</tr>
<tr>
<td>- Printing pictures and documents from an ANDROID OS Device</td>
<td>64</td>
</tr>
<tr>
<td><strong>7 Copying</strong></td>
<td></td>
</tr>
<tr>
<td>Copying a document</td>
<td>65</td>
</tr>
<tr>
<td>- Using the default settings to copy a document</td>
<td>65</td>
</tr>
<tr>
<td>- Adjusting the settings and copying a document</td>
<td>66</td>
</tr>
<tr>
<td>- Changing the number of copies of a document</td>
<td>68</td>
</tr>
<tr>
<td>- Enlarging or reducing a document</td>
<td>69</td>
</tr>
<tr>
<td>- Darkening or lightening a document</td>
<td>70</td>
</tr>
<tr>
<td>Copying a photo</td>
<td>71</td>
</tr>
<tr>
<td>- Using the default settings to copy a photo</td>
<td>71</td>
</tr>
<tr>
<td>- Adjusting the settings and copying a photo</td>
<td>72</td>
</tr>
<tr>
<td>- Changing the number of copies of a photo</td>
<td>74</td>
</tr>
<tr>
<td>- Enlarging or reducing a photo</td>
<td>75</td>
</tr>
<tr>
<td>- Darkening or lightening a photo</td>
<td>76</td>
</tr>
</tbody>
</table>
8 Scanning
Before you begin scanning ........................................................................................................... 77
  Changing the scan settings for scanning from the printer control panel ........................................... 78
Scanning from the control panel ................................................................................................. 80
  Scanning to a computer ................................................................................................................ 81
  Scanning to a memory card .......................................................................................................... 83
  Scanning to email .......................................................................................................................... 85
  Scanning to network folder ......................................................................................................... 86
Scanning from the computer ....................................................................................................... 87
  Scanning multiple pictures simultaneously ................................................................................ 88

9 Maintaining Your Printer
General care and cleaning ........................................................................................................... 89
  Cleaning the scanner glass and document backing ...................................................................... 90
Replacing ink cartridges ................................................................................................................. 92
Replacing the printhead ................................................................................................................ 95
Updating the software and printer firmware ................................................................................ 99
  Updating if your printer is connected to a computer with WINDOWS OS .................................... 99
  Updating if your printer is connected to a computer with MAC OS ............................................ 100
Checking ink levels ...................................................................................................................... 100
Resetting factory defaults ........................................................................................................... 100

10 Troubleshooting
Basic troubleshooting ..................................................................................................................... 101
Getting help on the Web ............................................................................................................. 103
Status lights .................................................................................................................................. 104
  Power light .................................................................................................................................... 104
  Wi-Fi connectivity LED ............................................................................................................ 104

11 Product and Safety Specifications
Specifications and features .......................................................................................................... 105
  Print performance ........................................................................................................................ 105
  Photo printing features ............................................................................................................... 105
  Copy document features ........................................................................................................... 105
  Copy photo features .................................................................................................................. 106
  Scanning features ..................................................................................................................... 106
  Paper input tray features ......................................................................................................... 106
  Paper types supported ............................................................................................................. 107
  Paper sizes supported .............................................................................................................. 107
  Ink cartridges ............................................................................................................................ 108
  Connectivity .............................................................................................................................. 108
  Software support ..................................................................................................................... 108
  Physical specifications .............................................................................................................. 109
  Warranty ..................................................................................................................................... 109
  System requirements ............................................................................................................... 109
Printer Overview

This printer lets you print, copy, and scan pictures and documents. In addition, this printer supports networking, letting you access the printer over a wireless (Wi-Fi) network.

Components

1. Left paper-edge guide*
2. Paper guard
3. Paper input tray
4. Scanner glass
5. Scanner lid
6. Control panel
7. Power button
8. Wi-Fi connectivity LED
9. Memory card slot
10. Access door
11. Printhead with ink cartridges installed
12. USB port
13. Power cord port
14. Paper output tray extender
15. Paper output tray

*Right paper-edge guide not shown. When you move one guide, both guides move.
# Control panel

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 LCD touch screen</td>
<td>Displays pictures, messages, and menus</td>
</tr>
<tr>
<td>2 Cancel button</td>
<td>Stops the current operation and returns to the previous menu, and closes the help screen</td>
</tr>
<tr>
<td>3 Start button</td>
<td>Begins copying, scanning, printing, maintenance tasks, and file transfer</td>
</tr>
<tr>
<td>4 Help button</td>
<td>Displays context-sensitive help</td>
</tr>
<tr>
<td>5 Back button</td>
<td>Displays the previous screen or the next highest screen in the menu</td>
</tr>
<tr>
<td>6 Home button</td>
<td>Displays the main menu</td>
</tr>
</tbody>
</table>
## Using the LCD touch screen

### Home Screen Menu

<table>
<thead>
<tr>
<th>Feature Icon</th>
<th>Displays...</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Copy Document settings and options</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Copy Photo settings and options</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>View and Print Photos options and settings</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>List of scan to options: Scan to Computer, Memory, Email, and Network Folder. Touching a scan-to option displays settings for that option.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>The list of forms that you can print from the control panel.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>Network settings</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>Printer settings</td>
</tr>
</tbody>
</table>
IMPORTANT: Use only your finger to touch the screen; other objects can damage the surface.

- To select a feature, touch the icon.
- To view the features, use the scroll bar:
  - Touch an arrow to scroll in that direction.
  - Touch the scroll bar to move to a different location.

### Home Screen Status Icons

Two status icons appear on the Home Screen:

- Touch the Wi-Fi icon to open the Networking Settings.
- Touch OK to dismiss the ink levels screen.
- Press  or  to dismiss the Network Settings screen.
When ink levels are low and require replacing, the attention graphic appears on the status icon. For example, if the level of black ink is low, the attention graphic appears on the blank ink icon:

![Attention graphic example]

Touch the icon to display instructions.

![Ink Levels screen]

Touch **OK** to return to the Home Screen.
Home Center Software

KODAK Home Center Software is installed with your KODAK All-in-One Printer Software, unless you choose otherwise. The Home Center icon will appear on your desktop (WINDOWS OS) or dock (MAC OS).

NOTE: You can choose to install the KODAK AiO Printer Software Essentials, which includes the printer drivers and Printer Tools (WINDOWS OS only).

On a computer with WINDOWS Operating System (OS), you can use Home Center Software to:

• browse, crop, enhance, and edit pictures
• print and scan
• make 3D pictures (from picture pairs taken to create 3D pictures)
• print from video
• send images to or print images from KODAK Gallery
• send images to or print images from FACEBOOK Social Network, FLICKR, PHOTOBUCKET, PICASA Photo Management Systems, and GOOGLE DOCS Program
• configure your printer
• install new network printers
• upgrade to the latest printer software and firmware
• order supplies
• access the KODAK Tips and Projects Center
• see the status of your printer
• set up Google Cloud Print™ and KODAK Email Print Service
• access the KODAK Online Printer Management Tool

On a computer with MAC OS, you can use Home Center Software to:

• scan
• configure your printer
• upgrade to the latest printer software and firmware
• order supplies
• see the status of your printer
• set up Google Cloud Print and KODAK Email Print Service
• access the KODAK Online Printer Management Tool
Ordering supplies

You can order ink cartridges, paper, and accessories online. An Internet connection is required.

To order supplies directly from Home Center Software:

1. Open Home Center Software.
2. Select **Order Supplies** (on a computer with WINDOWS OS) or select the **Tools** tab, then click **Order Supplies** (on a computer with MAC OS).
3. Select the item(s) you want to buy, then follow the on-screen instructions.

To order supplies from the Web:

- Ink: [www.kodak.com/go/printingsupplies](http://www.kodak.com/go/printingsupplies)
- Paper: [www.kodak.com/go/inkjetpaper](http://www.kodak.com/go/inkjetpaper)
Configuring printer settings

To set or change basic printer settings:

1. Press $\mathbb{H}$.
2. Press $\triangleright$, then touch Printer Settings.
3. Touch the following settings:

   - **Date and Time**
     - Touch Year, Month, Day, Hour, or Minute to change the individual settings. Touch $\leftarrow$ when you are done.
     
     NOTE: You can also synchronize the printer date and time to your computer using Home Center Software.

   - **Button Sounds**
     - Touch On or Off to set.

   - **Time to Low Power**
     To conserve energy, your printer will enter a low power (sleep) mode after being idle for a default delay time of 1 hour. You can increase the delay time to low power. Increasing the delay time may result in reduced energy savings.
     - Touch the time to low power (select from 1 to 4 hours in 0.5 hour increments). After the time to low power, the printer enters a low-power (sleep) mode.

   - **Tagged Images Printing** (see Printing tagged pictures, page 57)
     - Touch On or Off to set.

   - **Language**
     - Touch $\uparrow$ or $\downarrow$ to scroll through the languages, then touch a selection.

   - **Country/Region**
     - Touch $\uparrow$ or $\downarrow$ to scroll through the countries, then touch a selection.

   - **Reset All Settings** (see Resetting factory defaults, page 100)
     NOTE: Resetting factory defaults does not change the date and time, language, country/region, or network settings.

   - **Printer Info**
     - Touch to display the version of firmware currently running on the printer. Press OK when you are done.

4. Press $\downarrow$ to return to the Home Screen.
Networking Your Printer

This section explains how to configure your wireless network settings.

Connecting to a wireless network

To connect your printer to an 802.11b/g/n wireless (Wi-Fi) network, refer to the following information.

Before you connect

You need:

- a wireless router.
- to determine whether your wireless router supports Wi-Fi Protected Setup (WPS).

NOTE: If you have specific questions about your router, see your router manufacturer’s documentation for more information.
Connecting to a wireless network using the Wi-Fi Setup Wizard

You can use the Wi-Fi Setup Wizard on the printer to connect to your wireless network. Use the procedure that is appropriate for your network setup.

Connecting to a non-WPS wireless router

To connect your printer to your wireless network, you need to know the network name, also called the Service Set Identifier (SSID). You can obtain your network name from the wireless router. See the manufacturer’s documentation for more information.

If you have enabled security on your network, you also need to know the security string, which may be a Wired Equivalent Privacy (WEP) or a Wi-Fi Protected Access (WPA/WPA2) passphrase.

Record your network information using the correct uppercase and lowercase letters.

Network Name (SSID): ________________________________

Security String (case-sensitive): ________________________________

1. Press .

2. Touch , then touch Network Settings.

3. Touch Wi-Fi Setup Wizard.
   
   NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup Wizard.

   The Wi-Fi connectivity LED blinks as the printer searches for available wireless networks within range, then displays the list in order of signal strength. For example:

   ![Select Network to Connect]

   If there are additional networks than can be shown on the LCD, touch ▲ or ▼ to view them.
4. If the name of your network is:

<table>
<thead>
<tr>
<th>Listed</th>
<th>Not listed</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch your network name.</td>
<td>Make sure your wireless router is turned on and within range. If your wireless router does not broadcast its SSID (network name):</td>
</tr>
<tr>
<td></td>
<td>1. Touch ( \downarrow ), then touch <strong>Unlisted Network</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Use the LCD keyboard to enter your network name, then touch <strong>OK</strong>.</td>
</tr>
<tr>
<td></td>
<td>3. Touch <strong>WEP</strong> or <strong>WPA/WPA2</strong> as required for your network’s security setup.</td>
</tr>
<tr>
<td></td>
<td>NOTE: If the name of your network is still not listed, or you want to change your network, touch ( \downarrow ), then touch <strong>Rescan for Wireless Networks</strong>.</td>
</tr>
</tbody>
</table>

5. If your network has security enabled, use the LCD keyboard to enter your security string.

6. When the confirmation message appears, touch **OK**.

   When the printer is successfully connected, the Wi-Fi connectivity LED stops blinking and remains lit.

   The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP3.2+xxxx).

7. If you haven’t installed the KODAK All-in-One Printer Software:

   a. Go to [www.kodak.com/go/esp3_2downloads](http://www.kodak.com/go/esp3_2downloads) (for ESP 3.2 Printers) or [www.kodak.com/go/esp3_2sdownloads](http://www.kodak.com/go/esp3_2sdownloads) (for ESP 3.2s Printers).

   b. In the search results, click the link for KODAK All-in-One Printer Software for your computer operating system.

   c. Follow the on-screen instructions.
Connecting to a WPS wireless router

If your router supports Wi-Fi Protected Setup (WPS), you can use WPS Connect. WPS lets you configure your printer for a wireless network by pressing buttons or entering a PIN.

1. Press \( \text{Wi-Fi} \).
2. Touch \( \text{Network Settings} \), then touch \text{Network Settings}.
3. Touch \text{Wi-Fi Setup Wizard}.
   
   NOTE: The Wi-Fi radio turns on automatically when you select Wi-Fi Setup Wizard.

4. Touch \text{WPS Connect}.

5. Select one of two methods of connecting:

   IMPORTANT: Before you make a selection on the printer, make sure you know where the router’s push button is, or where to enter the generated PIN. If necessary, consult your Internet service provider or router device manufacturer’s documentation for more information.

<table>
<thead>
<tr>
<th>Push Button Configuration</th>
<th>Generate WPS PIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOTE: You will have two minutes to press or select the WPS button. It may be a button on the device or a virtual button in the device’s software.</td>
<td>a. Touch \text{Generate WPS PIN}.</td>
</tr>
<tr>
<td>a. Touch \text{Push Button Configuration}.</td>
<td>b. Record the PIN from the printer LCD.</td>
</tr>
<tr>
<td>b. Press or select the WPS button for your wireless router.</td>
<td>c. In your wireless router’s software, locate the PIN screen.</td>
</tr>
<tr>
<td>c. Touch \text{OK} on the control panel.</td>
<td>d. Enter the PIN you received on the LCD into the PIN screen, then follow the router’s instructions.</td>
</tr>
<tr>
<td>e. Touch \text{OK} on the control panel.</td>
<td></td>
</tr>
</tbody>
</table>

6. When the confirmation message appears, touch \text{OK}. 
When the printer is successfully connected, the Wi-Fi LED will stop blinking and remain lit.

7. If you haven’t installed the KODAK All-in-One Printer Software:
   a. Go to www.kodak.com/go/esp3_2downloads (for ESP 3.2 Printers) or www.kodak.com/go/esp3_2sd downloads (for ESP 3.2s Printers).
   b. In the search results, click the link for KODAK All-in-One Printer Software for your operating system.
   c. Follow the on-screen instructions.

**Setting up an IP Address**

**IMPORTANT:** You should only need to set up an IP Address for your printer if you are having a problem with connecting to your network. Typically, it is not necessary to set up an IP Address. This procedure is for advanced users who know how to obtain the IP Address for the printer.

1. Press 📰.
2. Touch ⏩, then touch **Network Settings**.
3. Touch **Advanced IP Address Setup**.
4. Touch **Yes** to continue.
5. Touch one of the following:
   - **Dynamic (DHCP)**
   - **Manual (Static)**
6. If you selected **Manual (Static)**, you are prompted to enter an IP Address, a Subnet Mask, a Gateway Address, and a DNS Server address. Touch **OK** after each entry. Use the navigation buttons to enter each digit.
   Consult your Internet service provider or network administrator for more information.
Viewing the network configuration

To view the network configuration and verify that you are connected to your wireless network:

1. Press 🌭.
2. Touch ➤, then touch **Network Settings**.
3. Touch **View Network Configuration**.
   The Network Configuration settings appear on the LCD, including:
   • Printer Hostname
   • Connection
   • Speed
   • IP Address
   • IP Address Type
   • Network Subnet
   • Connected Network SSID
   • Access Point MAC address
   • Security
   • Authentication
   • Channel
   • Region
   • Radio (on/off)
   • Wi-Fi Firmware Version
   • MAC Address
   If the printer is connected to your network, you will see the network name and the word CONNECTED.
4. To scroll through the information, touch ⬇.
5. When you are done, touch **OK**.

Printing the network configuration

1. Load plain paper into the printer. (See **Loading plain paper, page 43**.)
2. Press 🌭.
3. Touch ➤, then touch **Network Settings**.
4. Touch **Print Network Configuration**.
Installing your printer on additional computers on the network

To add your printer to another computer(s) on your network, install the KODAK All-in-One Printer Software on each computer.

1. Go to www.kodak.com/go/esp3_2downloads (for ESP 3.2 Printers) or www.kodak.com/go/esp3_2sdownloads (for ESP 3.2s Printers).
2. In the search results, click the link for your operating system.
3. Follow the on-screen instructions.

Connecting to another KODAK All-in-One Printer

If you are connecting to a newer model printer (for example, you have a HERO 3.1 Printer and now you are adding an ESP 3.2 Printer), you must install the software for the newer model.

NOTE: When you install the new software, the printer driver for the HERO 3.1 Printer will be uninstalled, and an upgraded driver for the HERO 3.1 Printer will be installed in addition to the driver for the ESP 3.2 Printer.

On a computer with WINDOWS OS:

1. Select Start > All Programs > Kodak > Kodak Printer Setup Utility.
   ▪ If your wireless printer (example: KodakESP3.2+xxxx) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. From the drop-down list, select your printer, then click Next.
     c. Select Network - Wireless/Wi-Fi, then click Next.
        When your printer is detected, driver installation begins.
   ▪ If your wireless printer (example: KodakESP3.2+xxxx) is listed:
     a. Select the printer that is connected to your network, then click Next.
     b. Select Yes, my printer is listed, then click Next.
        When your printer is detected, driver installation begins.
2. When driver installation is complete, click Done.

On a computer with MAC OS:

1. Select Apple > System Preferences.
2. Under Hardware, select Print & Fax or Print & Scan.
3. Click + in the dialog box.
4. Select your printer from the list.
5. Click Add, if required.
Adding a wireless network connection to a USB-connected computer

You can change the way you connect to your printer at any time.

Changing from USB to a wireless connection

If your printer is connected to a computer with WINDOWS OS:

1. Disconnect the USB cable from your printer and computer.
2. If you have not already done so, connect your printer to your wireless network. See Connecting to a wireless network, page 9.
3. On your computer, disable any firewall you have installed until you have successfully connected your printer.
4. Select Start > All Programs > Kodak > Kodak Printer Setup Utility.
   - If your wireless printer (example: KodakESP3.2+xxxx) is not listed:
     a. Select No, my printer is not listed, then click Next.
     b. Select your printer from the list, then click Next.
     c. Select Network - Wireless/Wi-Fi, then click Next. When your printer is detected, driver installation begins.
   - If your wireless printer (example: KodakESP3.2+xxxx) is listed:
     a. Select the printer that is connected to your network, then click Next.
     b. Select Yes, my printer is listed, then click Next. When your printer is detected, driver installation begins.
5. When driver installation is complete, click Done.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP3.2+xxxx).

If your printer is connected to a computer with MAC OS:

1. Disconnect the USB cable from your printer and computer.
2. If you have not already done so, connect your printer to your wireless network. See Connecting to a wireless network, page 9.
3. Select Apple > System Preferences.
4. Under Hardware, select Print & Fax or Print & Scan.
5. Click + in the dialog box.
6. Select your printer from the list.
7. Click Add, if required.

The printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP3.2+xxxx).
Connecting with Wi-Fi Direct™

NOTE: Wi-Fi Direct is a feature that is only on the ESP 3.2s All-in-One Printer (printer availability varies by country).

Your ESP 3.2s All-in-One Printer can be set up to host a Wi-Fi Direct network so you can connect mobile devices and computers* without using a router.

With Wi-Fi Direct, your printer works as an access point so you can:

- print from your mobile device using KODAK Pic Flick App.
- print or scan from your computer with WINDOWS OS or MAC OS (with the necessary drivers installed).
- access the Online Printer Management Tool.

IMPORTANT: For best results, use your device within 5 m / 16.4 ft of your printer. Check that there are no obstructions between your device and printer.

Wi-Fi Direct does not have Internet access. For full printer functionality, † connect your printer to your wireless network (see Connecting to a wireless network, page 9). Your printer can be connected to your wireless network and have Wi-Fi Direct enabled at the same time.

*You can connect up to four devices.
†An Internet connection is required for these features: Google Cloud Print™, KODAK Email Print Service, scan to email, and scan to network folder.
Networking Your Printer

Enabling and Using Wi-Fi Direct

1. Press 📡.
2. Touch ➧, then touch Network Settings.
3. Touch ➦, then touch Manage Wi-Fi Direct.
4. Touch Turn on Wi-Fi Direct.
5. Record the Wi-Fi Direct information displayed on the control panel:
   - Network Name (SSID): ____________________________________________
   - Security String: _________________________________________________
6. Touch OK.
7. Connect your device or computer to the network (SSID), then enter the security string. Use the information that you recorded in step 5.
8. To print from a mobile device, see Mobile Printing, page 61.
9. To print or scan from a computer, select your wireless printer (example: KodakESP3.2s+xxxx).
   If you do not see “+xxxx” after your printer name, you must download the printer drivers; follow the instructions below for your operating system.
   **On a computer with WINDOWS OS:**
   a. Select Start > All Programs > Kodak > Kodak Printer Setup Utility.
   b. Select No, my printer is not listed, then click Next.
   c. From the drop-down list, select your printer, then click Next.
      When your printer is detected, driver installation begins.
   d. When driver installation is complete, click Done.
   **On a computer with MAC OS:**
   a. Select Apple > System Preferences.
   b. Under Hardware, select Print & Fax or Print & Scan.
   c. Click + in the dialog box.
   d. Select your printer from the list.
   e. Click Add, if required.
10. For more information on printing, see Printing, page 50. For more information on scanning, see Scanning, page 77.
Connecting and Using Wi-Fi Direct for a Mobile Device or Computer with WPS

1. Press \[ \text{aising} \].
2. Touch \[ \text{상승} \], then touch \text{Network Settings}.
3. Touch \[ \text{下降} \], then touch \text{Manage Wi-Fi Direct}.
4. Touch \text{Connect a Device Using WPS}.

**IMPORTANT:** \textit{Before you make a selection on the printer, make sure you know:}

- the location of the push button on your mobile device or computer — it will be a button on your device, or a virtual button in the device software.
- where to generate a WPS Pin on your mobile device or computer.

5. Select one of these methods to connect your device:

<table>
<thead>
<tr>
<th>Push Button Configuration</th>
<th>Enter a WPS Pin</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong> You will have two minutes to press or select the WPS button.</td>
<td>a. Touch \text{Enter WPS Pin}.</td>
</tr>
<tr>
<td>a. Touch \text{Push Button Configuration}.</td>
<td>b. On your mobile device or computer, locate the Pin screen and generate a WPS Pin.</td>
</tr>
<tr>
<td>b. On your mobile device or computer, press (or select) the WPS button.</td>
<td>c. Enter the WPS Pin on your printer control panel, then touch \text{OK}.</td>
</tr>
<tr>
<td>c. Touch \text{OK} on your printer control panel.</td>
<td></td>
</tr>
</tbody>
</table>

6. To print from a mobile device, see \text{Mobile Printing}, page 61.
7. To print or scan from a computer:
   a. Go to \text{www.kodak.com/go/esp3_2downloads} (for ESP 3.2 Printers) or \text{www.kodak.com/go/esp3_2sdownloads} (for ESP 3.2s Printers).
   b. Select the All-in-One Printer Software for your operating system.
   c. Follow the on-screen instructions to install the software. (The printer and scanner drivers are installed when you install the software.)
   d. To print, see \text{Printing}, page 50. To scan, see \text{Scanning}, page 77.
Viewing your Wi-Fi Direct Network Configuration

1. Press \( \text{\textbullet} \).
2. Touch ↩, then touch **Network Settings**.
3. Touch \( \downarrow \), then touch **Manage Wi-Fi Direct**.
4. Touch **View Wi-Fi Direct Configuration**. The Wi-Fi Direct settings appear on the LCD. To scroll and review the settings, touch \( \downarrow \).
   • Wi-Fi Direct
   • SSID
   • Security String
   • IP Address
   • Subnet Mask
   • Channel
   • Region
   • MAC address
   • No. of devices connected
5. When you are done, touch **OK**.

Changing Wi-Fi Direct Settings

Your printer is assigned a network name (SSID), security string, and IP Address. You can change these settings, but you must reconnect your device to your printer after you make changes.

1. Press \( \text{\textbullet} \).
2. Touch ↩, then touch **Network Settings**.
3. Touch \( \downarrow \), then touch **Manage Wi-Fi Direct**.
4. Touch **Advanced Wi-Fi Direct Settings**.
5. Touch **Yes**.
6. Touch the setting you want to change: **SSID**, **Security String**, or **IP Address**.
7. Enter a new value, then touch **OK** to return to the Advanced Wi-Fi Direct Settings.
8. Reconnect your device or computer to your printer; use your new settings.
Online Printer Management Tool

The Online Printer Management Tool lets you access your printer through an Internet browser (such as INTERNET EXPLORER, FIREFOX, SAFARI, or CHROME) on any computer that is on the same network as your printer.

IMPORTANT: Your computer and your printer must be on the same wireless network. The Online Printer Management Tool is not available if your printer is connected to a computer with a USB cable.

With the Online Printer Management Tool, you can:

• view printer status
• configure (or change) printer settings
• create Scan to Email and Scan to Network Folder profiles (that you can access from the printer control panel)
• add entries to the Email Address book
• set up accounts for Google Cloud Print™ and KODAK Email Print Service
Accessing the Online Printer Management Tool

Access the Online Printer Management Tool in one of the ways described below.

**Directly from Home Center Software v7.x or higher:**

1. Open Home Center Software.
2. Select **Printer Tools** on a computer with WINDOWS OS, or **Tools** on a computer with MAC OS.
3. Make sure that the name of your wirelessly connected printer appears in the bottom of the window (WINDOWS OS only).

**NOTE:** A printer with a wireless connection is listed as the name of the printer plus a number (for example, KodakESP3.2+1133). If a different printer name appears, click **Select**, then choose your wirelessly connected printer.


**On any printer-supported computer:**

1. Get the IP Address of your wirelessly connected printer:
   a. On your printer control panel, press 🔄.
   b. Press ▼ to select **Network Settings**, then press **OK**.
   c. Press ▼ to select **View Network Configuration**, then press **OK**.

   **NOTE:** If you prefer a printout, press ▼ to select **Print Network Configuration**, then press **OK**. A Network Configuration Page prints, including the IP Address in the format xxx.xxx.xxx.xxx.

   d. Press ▼ to see the IP Address in the format xxx.xxx.xxx.xxx. (See Viewing the network configuration, page 14).

2. On your computer, open your preferred Internet browser (such as, INTERNET EXPLORER, FIREFOX, SAFARI, CHROME).
3. Type the printer IP Address in the browser address (URL) bar, then press **Enter**. The Online Printer Management Tool opens.
Using the Online Printer Management Tool

Configuring printer settings

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
3. Select Device.
4. Select General or Date & Time, and make any necessary changes.
5. Click Save.

NOTE: Select Reset to restore the default settings, if necessary.
Changing the printer name

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the **Network** tab.
3. Select **General**, then **Friendly name**, if necessary.
4. Highlight the text in the **Friendly name** field and type the name you want, then click **Save**.

Setting up Scan To Email

When you scan with your printer, you can send the scans directly from the printer to an email recipient. To do so, you must first set up a profile for yourself, and define the email address(es) to which you want to send scans.

Adding an outgoing email profile

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the **Settings** tab.
3. Select **Scan To Email > Email Profile**.
4. Click **Add New Outgoing Email Profile**.
5. In the **Profile Name** field, type a name that has meaning to you; for example, your initials and your email provider, such as LR Hotmail or LR Gmail. This name will appear on the printer control panel when you start a scan to be sent through email.

6. In the **From Email Address** field, type your email address. Although the email will be sent from the printer, any replies will go to this email address.
7. Under Email Server Settings, enter your email service provider.
   • If your email service provider is Gmail, Yahoo, AOL, or Hotmail, select your services from the drop-down menu. The Email Service and Port Number fields fill in automatically.
   • If your email service provider is not in the drop-down menu:
     a. Type the email server name or IP Address of your email service provider in the Email Server field.
     b. Type the port number of your email server in the Port Number field.
     NOTE: Locate this information in the email account properties fields in your email application.
     c. If your email server supports secure connection mode, select the Always use secure connection check box, or contact your Internet Service Provider.

8. If your email server requires authentication for sending emails:
   a. Select the The email server requires authentication for outgoing email check box.
   b. Type the User ID and Password for your email account.
9. If you want to limit who uses your profile (that appears on the printer LCD) to send scans:
   a. Select the **Enable Access PIN** check box.
   b. Type a 4-digit numeric **PIN** (your choice). You will need to enter this PIN each time you access your profile when scanning to an email address.

10. If you want a copy of all email messages, select the **Copy sender for all email messages sent from the printer** check box.

11. Click **Test Profile** to confirm that the printer can access your account.
   - If the printer can access your account, “Test profile: Successful” appears. Click **OK**, then click **Save**.
   - If the printer cannot access your account, “Test Profile: Failed” appears. Click **OK**, then make changes to your profile.

**Setting up the email address book**

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).

2. Select the **Settings** tab.

3. Select **Scan To Email > Address Book**.
4. For each person:
   a. Type the person’s Name.
   b. Type the person’s Email Address.
   c. Click Add.
5. When you are finished adding email addresses, click OK.

Setting options for scan to email

When you send a scan to an email address, the printer uses the defaults — subject line, body, and scan settings — that you set up under email options.

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
3. Select Scan To Email > Email Option.

4. Select and replace the default subject line and body text, if necessary. This subject line and body text will be included with every scan you send to an email address.
5. Select the scan settings that will be used for all scans sent to email:

NOTE: You can enter a Filename Prefix of your choice.

6. Click **Save**, then click **OK**.

You can now send a scan to an email address from the control panel. See Scanning from the control panel, page 80.
Setting up Scan To Network Folder

You can scan documents or photos directly to a file in a shared folder on your network.

Before you create a network folder profile

You must identify or create a network shared folder on a computer connected to the same network as your printer before you can create a network folder profile. Note the network name of the folder, including the path information, and the name of the computer where it is located.

To learn more about sharing folders, see the information in the links below.

- For computers with WINDOWS XP OS, see www.microsoft.com/windowsxp/using/networking/maintain/share.mspx
- For computers with WINDOWS VISTA OS, see technet.microsoft.com/en-us/library/bb727037.aspx
- For computers with WINDOWS 7 OS, see windows.microsoft.com/en-US/windows7/File-sharing-essentials
- For computers with MAC OS 10.5 or later, see support.apple.com/kb/ht1549
Adding a network folder profile

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
3. Select Scan To Network Folder > Network Folder Profile.
4. Click Add New Network Folder Profile.

![Network Folder Profile Image]
5. Type:
   - Profile Name
   - Folder Path

6. If the computer where the folder is located requires authentication to access its shared folders, type the network login **User Name** and **Password**.

7. If you want to limit who uses your profile to scan documents to your network folder:
   a. Select the **Enable Access PIN** check box.
   b. Type a 4-digit numeric **PIN** (your choice). You will need to enter this PIN each time you access your profile when scanning to a network folder.

8. Click **Test Profile** to confirm that the printer can access the network folder.
   - If the printer can access the network folder, “Test profile: Successful” appears. Click **OK**, then click **Save**.
   - If the printer cannot access the network folder, “Test Profile: Failed” appears. Click **OK**, then make changes to the network folder profile.

You are now ready to scan a document or photo to your network folder from the control panel. See **Scanning from the control panel, page 80**.
Setting scan settings for scan to network folder

When you send a scan to a network folder, the printer uses the defaults that you set up under scan settings.

1. Select **Scan To Network Folder > Scan Settings**.

2. Select the scan settings that will be used for all scans sent to a network folder:
   
   NOTE: You can enter a Filename Prefix of your choice.
   
3. Click **Save**, then click **OK**.

   You can now send a scan to a network folder from the printer control panel. See **Scanning from the control panel, page 80**.
Changing printer settings for copying and printing

You can change the default printer settings for copying documents and photos, and for printing photos.

Changing Copy Document and Copy Photo settings

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
3. Select Copy & Print > Copy Document or Copy Photo.
4. Make the changes you want in the appropriate fields, then click Save.
Changing Copy Document and Copy Photo settings (continued)
Changing Print Photo settings

1. Open the Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
3. Select Copy & Print > Print Photo.
4. Make the changes you want in the appropriate fields, then click Save.
Setting up Cloud Printing

Registering your printer with Google Cloud Print™ and KODAK Email Print Service

Your printer lets you print from anywhere in the world from your smartphone, tablet, or computer that uses Google Cloud Print enabled apps.

KODAK Email Print lets you send emails and email attachments to your printer using any email account.

You must register your printer with a GOOGLE Account to enable these features.

1. Make sure your printer and computer are connected to the same network (see Networking Your Printer, page 9).
2. Make sure you have the latest version of Home Center Software and printer firmware (see Updating the software and printer firmware, page 99).
3. Do one of the following:
   • Open Home Center Software, then click Cloud Printing Setup.
   • Depending on your Operating System, use the path below to select Cloud Printing Setup.
     - WINDOWS XP OS: Select Start > (All) Programs > Kodak > KODAK AiO Printer Tools. Click Cloud Printing Setup.
     - WINDOWS VISTA and 7 OS: Select WINDOWS icon > All Programs > Kodak > KODAK AiO Home Center > Printer Tools. Click Cloud Printing Setup.
4. In the Google Cloud Print Setup window, click Start Now.
5. Follow the on-screen instructions.

NOTE: You may need to sign in to your GOOGLE Account during the setup process.

6. When you see the “Thanks, you're ready to go!” message, close the window and return to the setup wizard (Google Cloud Print Setup).
7. Click Claim Address, then click Accept.

NOTE: If you want to change the email address of your printer, click Change Email and follow the on-screen instructions.

8. Make sure you have letter or A4 size paper loaded in the printer. A page will be sent to your printer to indicate that your printer has been successfully set up. This may take a few minutes. The page includes the email address of your printer.

For information about printing, see Printing using Google Cloud Print, page 61 and Printing using KODAK Email Print Service, page 62.
Editing a Google Cloud Print™ Account

Once you have successfully registered your printer with Google, you can make edits to various fields.

1. Open the KODAK Online Printer Management Tool (see Accessing the Online Printer Management Tool, page 22).
2. Select the Settings tab.
4. Click Edit Settings.
5. Make the changes you want in the appropriate fields, then click Save.

Editing the settings for KODAK Email Print Service

1. Do one of the following:
   • Go to www.kodakeprint.com.
   • If the Online Printer Management Tool is open, select the Settings tab, then Cloud Printing > KODAK Email Print Service. Click to edit options for KODAK Email Print Service.
2. If necessary, sign in with your GOOGLE Account.
3. Click Settings (next to your printer name). Make sure the check box next to Enabled is selected.

Changing the Email address for your printer

When you registered your printer with KODAK Email Print Service, an email address was assigned to your printer. To change the address to a more user-friendly name:

1. Click edit (next to the Printer Email address).
2. Type the new email address you want, then click Check to make sure it is an address you can use.
3. When you have a valid email address, click Accept.
4. Make sure you have letter or A4 size paper loaded in the printer. A page that includes the new address of your printer will print.

Printer Settings

You can make changes to the default settings, as needed.

1. With the Printer Settings tab selected, make any changes.
   If you clear the check box next to Print Email Body, only attachments will print.
2. Click Save.
 Allowed Users

To control who can send emails to your KODAK Printer email address:

1. Click the Allowed Users tab.
   Next to **Access Control**, click **Edit**.
2. From the drop-down list, select **Allowed Users**.
3. To add an email address to the allowed users, click **Add**.
4. Type the email or domain information, then click the Save icon.

**NOTE:** To delete an email or domain, click the Trash Can icon.

 History

Click the **History** tab to see a list of printed emails with the time, sender, subject, and status.

To delete an item from the list, click the check box next to it, then click the Trash Can icon.
Handling Paper

For the best document printing results, use KODAK Document Papers or a paper with the COLORLOK Technology logo on the package. Use only paper that is designed for inkjet printers.

For the best photo printing results, use KODAK Photo Papers, which are optimized to work with KODAK All-in-One Printers, or photo papers designed for use on pigment-based inkjet printers.

When handling photo paper:

- Hold the paper by the edges; avoid transferring fingerprints.
- Do not touch the glossy side of photo paper.
- Store paper flat, away from direct sunlight and heat.

Paper types

You can use:

- Plain paper — 16 to 24 lb / 60 to 90 gsm
- Photo paper — up to 12 mils
- Card stock — 110 lb / 200 gsm, max
- Envelopes — most standard types
- Labels — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
- Iron-on transfers — all commercially available inkjet varieties on 8.5 x 11-in. or A4 sheets
Paper sizes

The printer accepts the following paper sizes:

- 4 x 6 in. / 10 x 15 cm
- 4 x 7 in. / 10 x 18 cm
- 4 x 8 in. / 10 x 20 cm
- 4 x 12 in. / 10 x 31 cm
- 5 x 7 in. / 13 x 18 cm
- 7.3 x 8.5 in. / 18 x 22 cm
- US Executive (7.3 x 10.5 in. / 18 x 27 cm)
- 8 x 10 in. / 20 x 25 cm
- US Letter (8.5 x 11 in. / 22 x 28 cm)
- Legal (8.5 x 14 in. / 22 x 36 cm)
- A4 (8.3 x 11.7 in. / 21 x 30 cm)
- A5 (5.8 x 8.3 in. / 15 x 21 cm)
- A6 (4.1 x 5.8 in. / 11 x 15 cm)
- B5 (6.9 x 9.8 in. / 18 x 25 cm)

NOTE: Do not load paper smaller than 4 x 6 in. / 10 x 15 cm.
**Envelope sizes**

The printer accepts the following envelope sizes:

- C5 (6.7 x 9 in. / 16 x 23 cm)
- C6 (4.5 x 6.4 in. / 11 x 16 cm)
- DL (4.3 x 8.7 in. / 11 x 22 cm)
- US #7¾ (3.9 x 7.5 in. / 10 x 19 cm)
- US #9 (3.9 x 8.9 in. / 10 x 23 cm)
- US #10 (4.1 x 9.5 in. / 11 x 24 cm)

**IMPORTANT:** Do not load envelopes with cutout or clear windows.

**Loading paper**

**Loading plain paper**

The paper input tray capacity is 100 sheets of plain paper.

1. Lift the paper input tray.
2. Open the paper output tray, then pull the extender until it is fully extended.

3. Move the left and right paper-edge guides to the far left and far right positions.
4. Fan and stack the paper, then insert the paper into the paper input tray.
5. Move the paper-edge guides until they touch the paper.
Handling Paper

Loading photo paper

The paper input tray capacity is 20 sheets of photo paper.
1. Lift the paper input tray.

2. Open the paper output tray, then pull the extender until it is fully extended.
3. Move the left and right paper-edge guides for loading photo paper.

4. Insert photo paper (short side first) with the **logo side toward the tray** and the **glossy side toward you**.

   **IMPORTANT:** Always load the paper **short side first**. The printer automatically detects the orientation of the picture, whether it’s portrait or landscape, and prints accordingly. If the photo paper is loaded incorrectly, the image will be cut off and the paper may jam. If the paper is loaded with the wrong side up, the image quality will be affected.

5. Move the paper-edge guides until they touch the paper.
Loading envelopes

The paper input tray capacity is 20 envelopes.

IMPORTANT: Do not load envelopes with cutout or clear windows.

1. Lift the paper input tray.

2. Open the paper output tray, then pull the extender until it is fully extended.
3. Move the left and right paper-edge guides to the far left and far right positions.

4. Insert the envelope(s) with the flap toward the tray and the top of the envelope against the right side of the tray.

5. Move the paper-edge guides until they touch the envelope(s).
5 Printing

Print documents and lab-quality pictures on your printer.

Printing documents

1. Open the document on your computer.
2. Select File > Print.
3. In the Print dialog box, select your KODAK Printer.
4. Choose the pages to print, number of copies, etc, then click OK (on a computer with WINDOWS OS) or Print (on a computer with MAC OS).

Printing two-sided documents

You can print two-sided documents on any size paper that the printer accepts when you rotate the paper manually (see Paper sizes, page 42).

IMPORTANT: You can print two-sided documents on media that can absorb ink on both sides, such as plain paper or two-sided photo paper. You cannot print two-sided documents on bar-coded photo paper (the bar code is on the back side).

Printing two-sided documents from a computer with WINDOWS OS

1. Load paper into the paper input tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that KODAK ESP 3.2 AiO (or for a wireless connection, KodakESP3.2+XXXX, where XXXX is a number) is selected, then click Properties.
4. Select the Layout tab.
5. In the Two-sided printing field, select Manual, then click OK.
NOTE: You can also select manual two-sided printing from the two-sided printing shortcut or from the General tab under the Job settings field.
6. Under “Flip on:”, select Long edge or Short edge, then click OK.
7. When a message appears on your computer and control panel, remove the printed pages from the paper output tray, then follow the instructions on the control panel.
8. Press .
Printing two-sided documents from a computer with MAC OS

1. Load paper into the paper input tray.
2. Open the document you want to print, then select File > Print.
3. In the Print dialog box, make sure that Eastman Kodak Company KODAK ESP 3.2 AiO (or for a wireless connection, KodakESP3.2+XXXX, where XXXX is a number) is selected.
4. In the Print dialog box, select the two-sided check box.
5. Click Print.
6. When the even pages have finished printing, follow the instructions on the control panel to load the printed pages into the paper input tray.
7. Press .

Printing forms from the control panel

You can print the following forms:

- Graph paper
- Wide ruled page
- Narrow ruled page
- Grocery list
- Reminder list
- Tic-tac-toe
- Sheet music (portrait)
- Sheet music (landscape)

To print a form:

1. Press .
2. Touch , then touch Forms.
3. Touch a form to select it.
4. Use the LCD keyboard to type a quantity, then touch OK.
5. Press .
Printing pictures from a memory card

You can print pictures from the following memory cards:

- SD Card
- SDHC Card
- MMC Card
- MEMORY STICK
- Variations of the memory cards listed above that require an adapter (for example, MEMORY STICK Duo, miniSD, and microSD)

IMPORTANT: If you use a memory card with an adapter, make sure you insert and remove the adapter and the memory card as a unit; do not remove the memory card while leaving the adapter in the printer.

You can also print pictures using Home Center Software from your computer with WINDOWS OS. Home Center Software lets you edit and enhance your pictures quickly. Open Home Center Software, select Edit and Print Pictures, then follow the on-screen instructions.

On a computer with either MAC OS or WINDOWS OS, you can print pictures from KODAK EASYSHARE Software or any picture-editing or photo-management software.

Viewing pictures on a memory card

When you insert a memory card into the card slot on your printer, touch View and Print Photos, View Photos, then touch or to scroll through the pictures.

You can locate pictures on a memory card by the date the picture was taken or last saved.

1. Insert the memory card into the memory card slot.
2. Press , then touch Options, Find Photos.
3. Touch Year, Month, and Day to set the values.
   The number of photos found for the date you specified appears under the menu name.
4. Touch OK to view the pictures.
Using default settings to print a picture

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Insert the memory card into the memory card slot.

3. Touch ‹ or › to display the picture you want to print.
4. Press ‹ to begin printing.

The printer prints one 4 x 6 in. / 10 x 15 cm picture.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the printer while printing or viewing pictures.
Changing the settings and printing pictures

You can change the print photos options for an individual picture or group of pictures, or you can change the settings and save them as the default.

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Insert the memory card into the memory card slot.
3. Touch ▼ or ▲ to select the picture you want to print, then touch ▼ or ▲ to change the quantity.
4. Repeat step 3 for each picture you want to print.
5. Press ✪ and touch Options.
6. Touch ▼ or ▲ and touch the setting you want to change.

<table>
<thead>
<tr>
<th>Print Photos Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Photos</td>
<td>--</td>
<td>Scroll through the pictures on the memory card; touch ▼ or ▲ to select a quantity for printing; press ✪ to display the View and Print Photos Settings.</td>
</tr>
<tr>
<td>Find Photos</td>
<td>--</td>
<td>Touch Year, Month, and Day to set the values, then touch OK to view photos by the date that they were taken; press ✪ to display the View and Print Photos Settings menu.</td>
</tr>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color (default)</td>
<td>Prints full color.</td>
</tr>
<tr>
<td></td>
<td>Black &amp; White</td>
<td>Prints black and white (grayscale).</td>
</tr>
</tbody>
</table>
7. When you have finished changing settings, press ![enter].

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the printer while printing.

<table>
<thead>
<tr>
<th>Print Photos Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Size</td>
<td>2 x 3</td>
<td>If the selected copy size is smaller than the paper in the paper input tray, the printer automatically arranges the pictures to best fit the paper size.</td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6 (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 or A4</td>
<td></td>
</tr>
<tr>
<td>Quality applies to plain paper only; Best is automatically selected for photo paper</td>
<td>Normal (default)</td>
<td>Good quality output; prints faster than Best.</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>The highest quality, but the slowest print speed.</td>
</tr>
<tr>
<td></td>
<td>Draft</td>
<td>The fastest print speed, but the lowest quality.</td>
</tr>
<tr>
<td>Scene Balance</td>
<td>On (default)</td>
<td>Adjusts the image brightness to correct for underexposure and reduces the variation in contrast in different areas of the picture.</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Add Date to Prints</td>
<td>No (default)</td>
<td>Prints the date of the picture(s) (the date the picture was taken or last edited) in a corner of the print.</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Transfer to PC</td>
<td>--</td>
<td>To transfer all the pictures on the memory card to your computer, press ![enter]. (Your printer and computer must be connected with a USB cable.)</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new defaults, touch Yes.</td>
</tr>
</tbody>
</table>
Printing panoramic pictures

To print panoramic pictures, you will need to load 4 x 12 in. / 10 x 31 cm paper, or US letter or A4 paper.

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Insert the memory card into the memory card slot.
3. Touch \ or \ to select the panoramic picture you want to print, then touch \ or \ to select a quantity.
4. Press \ and touch Options.
5. Touch \, Print Size, then touch \, 4 x 12.
6. Press \.

IMPORTANT: To prevent loss of data from your memory card, do not remove it from the printer while printing or viewing pictures.
Printing tagged pictures

Some digital cameras let you tag (or “mark”) pictures on the memory card for printing. This creates a tag that is recognized by the printer. If you choose to print tagged pictures, they will be printed according to the default settings on your printer (unless otherwise specified by the tag from the camera).

NOTE: Refer to your camera user guide to determine if your camera supports tagged (also “marked” or “DPOF”) functionality.

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Insert the memory card into the memory card slot.

3. When the message “Print tagged images?” appears, press .
Zooming and cropping pictures

Use the zoom buttons to select a portion of your picture for printing.

1. Insert the memory card into the memory card slot.

2. Touch ◄ or ► to select the picture you want to crop, then touch <<.

3. Press Zoom + to enlarge the picture on the LCD. A red box shows the area that will be printed.

   NOTE: You can press Zoom + repeatedly to enlarge the picture in increments of 0.25 up to a magnification of 5X. Press Zoom - to decrease the magnification in increments of 0.25 down to 1X.

4. Touch ◄ to rotate the crop box, if necessary.

   IMPORTANT: Always load the paper short side first. The printer automatically detects the orientation of the picture, whether it’s portrait or landscape, and prints accordingly. If the photo paper is loaded in the wrong direction, the image will be cut off and the paper may jam. If the paper is loaded with the wrong side up, the image quality will be affected.

5. Use the navigation buttons ◄, ►, ◄, and ► to move the picture on the LCD up, down, left, or right. Only the part of the picture in the red box will print. The crop window matches the aspect ratio of the selected output print size.

   NOTE: Zooming and cropping does not change the saved picture on the memory card.

6. When you are satisfied with the picture, touch ✎. The picture appears in the original view with a red box around the portion of the picture that will print.

7. Press ◄ to begin printing.
Printing pictures from a wireless device

You can print pictures wirelessly at the touch of a button from:

- iPhone (iOS 3.0 or later)
- iPod Touch (2nd generation)
- iPad
- BLACKBERRY Device (software v4.5 or later)
- a device running ANDROID OS v2.0 or later

For more information, see Mobile Printing, page 61, or go to www.kodak.com/go/mobile.

Transferring pictures to a computer

You can transfer your image files from a memory card in the printer to your computer. To transfer these files, the printer **must** be connected to your computer with a USB cable.

**NOTE:** If you have large video files or a large number of pictures (400 or more), we recommend that you transfer them using a memory card reader attached directly to your computer.

Transferring pictures to a computer with WINDOWS OS

1. Insert the memory card into the memory card slot on the printer.
2. Press .
3. Touch **Options**.
4. Touch , then **Transfer to PC**.
5. Press .
6. If your computer is connected to a wireless network and with a USB cable, select the USB printer (no number after the printer name).
7. Follow the on-screen instructions on your computer.

Transferring pictures to a computer with MAC OS

1. Insert the memory card into the memory card slot on the printer.
2. Press .
3. Touch **Options**.
4. Touch , then **Transfer to PC**.
5. Press .
6. If your computer is connected to a wireless network and with a USB cable, select the USB printer.
7. Use iPhoto or Image Capture Software on your computer to complete the transfer.
Printing picture collages using KODAK Photo Collage Print App

KODAK Photo Collage Print App is a FACEBOOK Application that allows you to create and print photo collages from FACEBOOK albums.

Adding KODAK Photo Collage Print App to your FACEBOOK Account:

1. Log on to your FACEBOOK Account.
2. Go to apps.facebook.com/kodakcollage.
3. Click Allow. The application opens.

Printing from KODAK Photo Collage Print App:

1. Click the Templates button.
2. Select the template you want to use.
3. Select the Select Photos tab.
4. Click the triangles on the left side of the screen to view FACEBOOK photo albums, then select the photo albums you want to use.

NOTE: You can use your albums, your friends’ albums, or both.

5. Click the Template tab to choose a layout design.
6. Hover your mouse over a photo to show the editing tools.
   The editing tools allow you to:
   • refresh the photo, which swaps the photo with another in your chosen album(s)
   • pan and zoom
   • move a photo from one position to another on the collage
7. When you finish the collage, click Continue.
8. To share your collage, click Share. The collage will be posted to your FACEBOOK wall and will be saved to your FACEBOOK photo albums.
9. To print your collage:
   • Load 8.5 x 11 in. (22 x 28 cm) photo paper into your printer
   • Click Print.
Mobile Printing

Mobile printing lets you print to your all-in-one printer from your Web-connected mobile device.

When your:

- printer is registered to Google Cloud Print™, you can print from anywhere with your mobile device using Google Cloud Print apps.
- printer has an email address (assigned by KODAK Email Print Service), you can send emails and email attachments to your printer from anywhere, from a device capable of sending email.
- mobile device is connected to the same wireless network as your printer, you can print pictures using a KODAK Pic Flick App.

When you plan to use mobile printing, make sure that your printer power is on or your printer is in low power mode (for information, see Time to Low Power under Configuring printer settings, page 8).

Printing using Google Cloud Print

Print on the go from your smartphone, computer, or tablet using Google Cloud Print enabled apps.

Before you can use Google Cloud Print, make sure your printer is set up for Google Cloud Print. See Registering your printer with Google Cloud Print™ and KODAK Email Print Service, page 38.

Printing varies by application. For more information, go to www.google.com/cloudprint/learn/apps.html.

To print from a Chromebook:

Click the wrench and select Print to print the Web page you are viewing (you can also use the keyboard shortcut Ctrl+P).

To print from an iOS mobile device (iPhone, iPad, iPod Touch):

- From GMAIL:
  - Email body: Select the email, then click the menu in the top-right corner and select Print.
  - Attachment: Click the Print button next to the attachment.
- From GOOGLE DOCS Program:
  - Select the document, then click the menu in the top-right corner and select Print.

To print from an ANDROID OS device:

Install the Google Cloud Print App from the ANDROID Market.
To print from a computer:
Install the CHROME Extension (plug in) from the CHROME Web store, then:

- From GMAIL:
  - Email body: Select the email, then click the Print all using Google Cloud Print link at the top right of the email.
  - Attachment: Select Print attachment using Google Cloud Print.
- From GOOGLE DOCS Program:
  - Select File > Print using Google Cloud Print.
- Web pages (URL must end with .pdf, .doc, or .txt):
  - Click Print using Google Cloud Print when it appears on the URL address bar.
  - For the latest information on supported formats, go to the CHROME Extension (plug in) Web site.

To print from a BLACKBERRY OS device:
We recommend using KODAK Email Print.

Printing using KODAK Email Print Service

Printing emails, documents, and pictures

KODAK Email Print lets you send emails and email attachments (documents and pictures) to your printer from anywhere, using any device capable of sending email.

NOTE: Before you can use KODAK Email Print, your printer must be registered to Google Cloud Print™ and KODAK Email Print (see Registering your printer with Google Cloud Print™ and KODAK Email Print Service, page 38).

To print using KODAK Email Print:
1. Make sure that your device or computer is connected to the Internet.
2. Open an email application (such as GMAIL, MICROSOFT OUTLOOK, HOTMAIL, YAHOO, iOS Mail, or ANDROID OS Mail).
3. Address the email to your printer email address. Attach the files you want to print; if needed, include any comments in the body of the email.
4. Send the email.
   The email attachments (and any comments) will print to your printer.
Printing from a mobile device

When connected to the same Wi-Fi network, you can print pictures wirelessly with your all-in-one printer from:

- an iPhone (iOS 3.0 or later), iPod Touch device (2nd generation), iPad (may not be available with all models).
- a BLACKBERRY Device (software v4.5 or later).
- a device running ANDROID OS v2.0 or later.

Download the KODAK Pic Flick App from the App Store directly from your device, then follow the procedure for your device. For information, go to www.kodak.com/go/mobile.

Printing pictures from an iPhone, iPad, or iPod Touch device

IMPORTANT: Requires iOS 3.0 or later.

To print a picture from an iPhone, iPad, or iPod Touch device (2nd generation):
1. Make sure your device is connected to the same Wi-Fi network as your printer.
2. Open the KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print, then select Choose Device.
4. Select your KODAK All-in-One Printer from the list of available devices.
5. Select Send.

Printing pictures from a BLACKBERRY Device

To print a picture from a BLACKBERRY Device (software v4.5 or later):
1. Make sure your BLACKBERRY Device is connected to the same Wi-Fi network as your printer.
2. Open the KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print.
4. Press the Menu key, then select Print.
5. Select your KODAK All-in-One Printer from the list of available devices.
   NOTE: It may take a few minutes for the printer to appear in the Available Printers list.
6. Select the print size and enter the number of copies.
7. Select Print.
Printing pictures and documents from an ANDROID OS Device

NOTE: ANDROID OS v2.0 or later required.

To print a picture using KODAK Pic Flick App:

1. Make sure your device is connected to the same Wi-Fi network as your printer.
2. Open KODAK Pic Flick application on your device.
3. Select the picture(s) you want to print.
4. Select View/Edit to edit the picture(s), or go to step 5.
   a. Press and hold the screen to enter the edit mode.
   b. Rotate, move, pan, zoom, or crop the picture.
5. Press Select Device, then select your KODAK All-in-One Printer.
6. Select the print size.
7. Press Back, then select Send.

To print a picture or document using KODAK Document Print App:

IMPORTANT: Before you can use KODAK Document Print App, your printer must be registered to Google Cloud Print™ (see Registering your printer with Google Cloud Print™ and KODAK Email Print Service, page 38).

1. Download and install the app from the ANDROID Market.
2. Launch the KODAK Document Print App.
3. Locate the picture or document you want to print.
4. Sign in with your GOOGLE Account, then select OK.
5. Select your printer from the list.
6. Select Print.
You can copy documents and pictures with your all-in-one printer. The printer produces high-quality color or black-and-white copies on a variety of paper (see Paper types, page 41).

Copying a document

You can copy a document using the default settings, or you can adjust the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a document

The default settings are either the factory default settings (see Resetting factory defaults, page 100), or defaults that you have set on the printer (see the bottom entry in the table under Adjusting the settings and copying a document, page 66).

To copy a document using the current default settings:

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press .
5. Press .
Adjusting the settings and copying a document

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press .
5. Touch Options, then touch or (as needed) and touch the setting you want to change.

<table>
<thead>
<tr>
<th>Copy Document Option</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color (default)</td>
<td>Prints full color.</td>
</tr>
<tr>
<td></td>
<td>Black &amp; White</td>
<td>Prints black and white (grayscale).</td>
</tr>
<tr>
<td>Copy Size</td>
<td>Same Size</td>
<td>The copy is the same size as the original.</td>
</tr>
<tr>
<td></td>
<td>(default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Fit to Page</td>
<td>The printer detects the size of the original on the scanner glass and the size of the paper in the paper input tray, and automatically reduces or enlarges the original so that the copy fits on the paper.</td>
</tr>
<tr>
<td></td>
<td>20% to 500%</td>
<td>Reduces to 20% or enlarges to 500% of the original size.</td>
</tr>
<tr>
<td>Copy Document Option</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td>Quality (applies to plain paper only; quality is automatically selected for photo paper)</td>
<td>Normal (default)</td>
<td>Good quality output; prints faster than Best.</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>The highest quality, but the slowest print speed.</td>
</tr>
<tr>
<td></td>
<td>Draft</td>
<td>The fastest print speed, but the lowest quality.</td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Normal 0 (default)</td>
<td>Lightens or darkens the copy. Normal 0 is no change from the original; –3 is the darkest; +3 is the lightest.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new defaults, touch Yes.</td>
</tr>
</tbody>
</table>

6. Press ➤.
Changing the number of copies of a document

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press \[ \text{Home} \].
4. Touch **Copy Document**, then touch \[ \langle \] or \[ \rangle \] to select a quantity.
5. Press \[ \text{Start} \].
Enlarging or reducing a document

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.
2. Close the lid.
3. Press \( \text{Home} \).
4. Touch **Copy Document**.
5. Touch **Options**, then **Copy Size**.
6. Touch an enlargement or reduction selection.
7. Press \( \text{Start} \).
Darkening or lightening a document

1. Lift the scanner lid, and place the document face down in the right-front corner of the scanner glass.

2. Close the lid.

3. Press $\text{Start}$.


5. Touch Options, then Lighter/Darker.

6. Touch $\downarrow$ to scroll to a number below zero for a darker copy, or touch $\uparrow$ to scroll to a number above zero for a lighter copy.

7. Touch the setting you want to apply.

8. Press $\text{Start}$. 
Copying a photo

You can copy a photo using the default settings, or you can adjust the quantity, size, quality, and brightness of your copies.

Using the default settings to copy a photo

The default settings are either the factory default settings (see Resetting factory defaults, page 100), or defaults that you have set on the printer (see the bottom entry in the table under Adjusting the settings and copying a photo, page 72).

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Lift the scanner lid, and place the photo face down in the right-front corner of the scanner glass.
3. Close the lid.
4. Press .
5. Touch Copy Photo.
6. Press .
Adjusting the settings and copying a photo

1. Load photo paper into the printer (see Loading photo paper, page 46).
2. Lift the scanner lid, and place the photo face down in the right-front corner of the scanner glass.
3. Close the lid.
4. Press \( \text{COPY} \).
5. Touch Copy Photo.
6. Touch Options, then touch \( \uparrow \) or \( \downarrow \) and touch the setting you want to change.

<table>
<thead>
<tr>
<th>Copy Photo Option</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantity</td>
<td>1 (default) to 99</td>
<td>The number of copies that print.</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Color (default)</td>
<td>Prints full color.</td>
</tr>
<tr>
<td></td>
<td>Black &amp; White</td>
<td>Prints black and white (grayscale).</td>
</tr>
<tr>
<td>Copy Size</td>
<td>2 x 3</td>
<td>The printer detects the size of the original on the scanner glass and the size of the paper in the paper input tray, and automatically reduces or enlarges the original so that the copy fits on the paper.</td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6 (default)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11 or A4</td>
<td></td>
</tr>
<tr>
<td>Lighter/Darker</td>
<td>Normal 0 (default)</td>
<td>Lightens or darkens the copy. Normal 0 is no change from the original; (-3) is the darkest; (+3) is the lightest.</td>
</tr>
<tr>
<td></td>
<td>−3 to +3</td>
<td></td>
</tr>
<tr>
<td>Copy Photo Option</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Quality</td>
<td>Normal</td>
<td>Good quality output; prints faster than Best.</td>
</tr>
<tr>
<td></td>
<td>Best</td>
<td>The highest quality, but the slowest print speed.</td>
</tr>
<tr>
<td></td>
<td>Draft</td>
<td>The fastest print speed, but the lowest quality.</td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new defaults, touch Yes.</td>
</tr>
</tbody>
</table>

7. Press .

www.kodak.com/go/aiosupport
Changing the number of copies of a photo

1. Lift the scanner lid, and place the photo face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press $\text{ home}$.
4. Touch **Copy Photo**.
5. Press $< \text{ or } >$ to select a quantity.
6. Press $\text{ start}$.
Enlarging or reducing a photo

1. Lift the scanner lid, and place the photo face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press \( \text{Home} \).
4. Touch **Copy Photo**.
5. Touch **Options > Copy Size**.
   
   NOTE: Make sure that the paper loaded in the paper input tray is at least as wide as the Copy Size selected, or you will get a wrong paper size error. Also, if the loaded paper is not as long as the Copy Size selected, the output picture will be cut off without any warning.

6. Touch a size selection.
7. Press \( \text{Start} \).
Darkening or lightening a photo

1. Lift the scanner lid, and place the photo face down in the right-front corner of the scanner glass.

2. Close the lid.
3. Press \home.
4. Touch **Copy Photo**.
5. Touch **Lighter/Darker**.
6. Touch ▼ to select a number below zero for a darker copy, or touch ▲ to select a number above zero for a lighter copy.
7. Press ►.
Scanning

Scanning digitizes documents and pictures, and sends the digital files to your computer or memory card.

When you scan, the digital file can:

- open in Home Center Software (when Home Center Software is loaded and the printer is connected to a computer with WINDOWS OS)
- open in a third-party scanner software
- be saved in a format and location that you determine (see Changing the scan settings for scanning from the printer control panel, page 78)

Scanning from a software program on the computer (such as Home Center Software) gives you more options, but you can also scan from the printer control panel.

Before you begin scanning

If you are scanning to a computer, make sure that the printer is connected to a computer using a USB 2.0 cable or wireless network (see Networking Your Printer, page 9). If you plan to scan directly from the printer control panel, you can change the settings as described below.
Changing the scan settings for scanning from the printer control panel

If you want to adjust the scan settings that the printer uses, do so before you scan from the printer control panel.

1. Open Home Center Software, then open the Printer Tools (WINDOWS OS) or Tools (MAC OS) window.

   NOTE: To get to Printer Tools without Home Center Software (WINDOWS OS only), select Start > All Programs > Kodak > KODAK AiO Printer Tools.

2. Under the Tools heading, select Printer Scan Settings.

3. Adjust settings for scanning documents and pictures:
   a. To select a program that scanned images or documents will appear in when you scan from the printer control panel:
      (1) Select the General tab.
      (2) Under the Program List heading, click ▼ next to the currently selected program.
      (3) From the drop-down list, select the program in which you want the scanned files to open.
   b. To adjust settings for scanning documents, select the Document tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>File format</td>
<td>.pdf</td>
</tr>
<tr>
<td></td>
<td>.rtf (available only when connected to a computer with WINDOWS OS)</td>
</tr>
<tr>
<td></td>
<td>.tif</td>
</tr>
<tr>
<td></td>
<td>.jpg</td>
</tr>
<tr>
<td></td>
<td>.bmp (available only when connected to a computer with MAC OS)</td>
</tr>
<tr>
<td>Resolution (dpi)</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>300</td>
</tr>
<tr>
<td>File Save</td>
<td>Prompt for File Name and Location</td>
</tr>
<tr>
<td></td>
<td>Automatically Save - specify:</td>
</tr>
<tr>
<td></td>
<td>• Base name; by default, scanned files are named “scan1”, “scan2”, and so on.</td>
</tr>
<tr>
<td></td>
<td>• Location (folder) where the scanned files will be saved</td>
</tr>
</tbody>
</table>
c. To adjust settings for scanning pictures, select the **Picture** tab, then select an option for each setting:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan As</td>
<td>Color&lt;br&gt;Black and white</td>
</tr>
<tr>
<td>File format</td>
<td>.jpg&lt;br&gt;.bmp&lt;br&gt;.tif</td>
</tr>
<tr>
<td>Resolution (dpi)</td>
<td>75&lt;br&gt;150&lt;br&gt;200&lt;br&gt;300&lt;br&gt;600</td>
</tr>
<tr>
<td>Quality</td>
<td>When connected to a computer with WINDOWS OS:&lt;br&gt;• Best for E-mail&lt;br&gt;• Normal&lt;br&gt;• High&lt;br&gt;• Maximum&lt;br&gt;When connected to a computer with MAC OS, a slider bar with:&lt;br&gt;• Least&lt;br&gt;• Medium&lt;br&gt;• Best</td>
</tr>
<tr>
<td>Automatically Detect Pictures</td>
<td>When selected, multiple pictures placed on the scanner glass are saved as separate files.</td>
</tr>
<tr>
<td>(when connected to a computer with WINDOWS OS) or Auto Crop (when connected to a computer with MAC OS)</td>
<td></td>
</tr>
<tr>
<td>File Save</td>
<td>Prompt for File Name and Location&lt;br&gt;Automatically Save - specify:&lt;br&gt;• Base name; by default, scanned files are named “scan1”, “scan2”, and so on&lt;br&gt;• Location (folder) where the scanned files will be saved</td>
</tr>
</tbody>
</table>

**NOTE:** Before you save a scanned file in Home Center Software, you can preview, crop, and sharpen the image, and adjust the color. On a computer with WINDOWS OS, see the Home Center Software Help (❓ icon) for instructions.
4. When you are finished making selections, click **OK** on the bottom right of the Printer Scan Settings window.
5. Close the Printer Tools window.

**Scanning from the control panel**

When you scan a document or picture(s) from the control panel, you have the following options:

- **Scan to Computer** - scans to a file or to Home Center Software on your computer
- **Scan to Memory Card** - scans to a memory card in the memory card slot
- **Scan to Email** - scans to an email address that you select from the Email Profile you set up in the Online Printer Management Tool
- **Scan to Network Folder** - scans to a shared network folder that you designated in the Online Printer Management Tool

* Before you can use these options, you must set up Scan to Email (see Setting up Scan To Email, page 24) and Scan to Network Folder (see Setting up Scan To Network Folder, page 31) from the Online Printer Management Tool.
Scanning to a computer

1. Lift the scanner lid, and place the original face down in the right-front corner of the scanner glass, then close the lid.

2. Close the lid.
3. Press .
4. Touch Scan.
5. Touch Scan to Computer, then touch the setting/option you want to change.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan To</td>
<td>USB Computer (default)</td>
<td>The scanned file is sent to the USB Computer.</td>
</tr>
<tr>
<td></td>
<td>Name of computer (only if a computer is connected by wireless network)</td>
<td>The scanned file is sent to the computer on the wireless network.</td>
</tr>
<tr>
<td>Scan What</td>
<td>Document (default)</td>
<td>Sets the scan settings for scanning a document (see Changing the scan settings for scanning from the printer control panel, page 78).</td>
</tr>
<tr>
<td></td>
<td>Photo</td>
<td>Sets the scan settings for scanning a picture (see Changing the scan settings for scanning from the printer control panel, page 78).</td>
</tr>
</tbody>
</table>
6. Press \( \text{Scan} \).
7. When the message “Scan complete” appears, touch OK. The scanned file appears at the destination you specified.
Scanning to a memory card

1. Lift the scanner lid, and place the original face down in the right-front corner of the scanner glass, then close the lid.

2. Close the lid.
3. Press \[ \text{Scan} \].
4. Touch `Scan`.
5. Touch `Memory Card`, then touch the setting/option you want to change.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan What</td>
<td>Photo (default)</td>
<td>Sets the scan settings for scanning a picture (see Changing the scan settings for scanning from the printer control panel, page 78).</td>
</tr>
<tr>
<td></td>
<td>Document</td>
<td>Sets the scan settings for scanning a document (see Changing the scan settings for scanning from the printer control panel, page 78).</td>
</tr>
<tr>
<td>File Type</td>
<td>JPG (default)</td>
<td>The scanned file is saved as a JPG.</td>
</tr>
<tr>
<td></td>
<td>Single-page PDF</td>
<td>The scanned file is saved as a single-page PDF.</td>
</tr>
<tr>
<td></td>
<td>Multi-page PDF</td>
<td>The scanned file is saved as a multiple-page PDF.</td>
</tr>
</tbody>
</table>
6. Press \( \text{Scan} \).
7. When the message “Scan complete” appears, touch **OK**. The scanned file appears at the destination you specified.

<table>
<thead>
<tr>
<th>Scan Option</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Size</td>
<td>Auto (default)</td>
<td>Determines the size that is scanned.</td>
</tr>
<tr>
<td></td>
<td>2 x 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 12</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8.5 x 14</td>
<td></td>
</tr>
<tr>
<td>Save as Defaults</td>
<td>No / Yes</td>
<td>To save the settings as the new defaults, touch <strong>Yes</strong>.</td>
</tr>
</tbody>
</table>
Scanning to email

You can scan your original and immediately send the scanned file by email to one or more recipients directly from the printer.

NOTE: You must first use the Online Printer Management Tool to set up scanning to email options (see Setting up Scan To Email, page 24).

1. Lift the scanner lid, and place the original face down in the right-front corner of the scanner glass, then close the lid.

2. Close the lid.

3. Press.

4. Touch Scan.

5. Touch Email.

6. Select an outgoing email profile (the person from whom the email with the scan attachment is sent), then press OK.

7. If necessary, enter the 4-digit PIN number (see Step 9, page 28), select Done, then press OK.

8. Select an email recipient, then press OK.

9. Repeat step 8 for each recipient.

10. Press.

11. When the message “Scan complete” appears, touch OK. The scanned files appears at the destination you specified.
Scanning to network folder

You can scan your original and immediately send the scanned file to a network folder directly from the printer.

NOTE: You must first use the Online Printer Management Tool to set up scanning to network folder options (see Setting up Scan To Network Folder, page 31).

1. Lift the scanner lid, and place the original face down in the right-front corner of the scanner glass, then close the lid.

2. Close the lid.
3. Press \( \text{home} \).
4. Touch \( \text{Scan} \).
5. Touch \( \text{Scan to Network Folder} \).
6. Touch \( \text{Sharing folder} \).
7. If necessary, enter the 4-digit PIN number (see 9, page 28), then touch \( \text{OK} \).
8. Press \( \text{play} \).
9. When the message “Scan complete” appears, touch \( \text{OK} \). The scanned file appears at the destination you specified.
Scanning from the computer

1. Lift the scanner lid, and place the document or picture face down in the right-front corner of the glass.

2. Close the lid.

3. Open Home Center Software.
   - On a computer with WINDOWS OS, select Scan Documents and Pictures, then follow the on-screen instructions.
   - On a computer with MAC OS, select the Tools tab, click Scan Application, then follow the on-screen instructions.

NOTE: If you are not using Home Center Software, open a program that allows you to scan, then follow the instructions.
Scanning multiple pictures simultaneously

Using Home Center Software, you can scan multiple pictures simultaneously and save them as separate files.

When scanning multiple pictures, leave space between the pictures so that the printer can detect the separate pictures. Any pictures that overlap are interpreted as a single picture.

Scanning multiple pictures when connected to a computer with WINDOWS OS

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the lid.
3. Open Home Center Software, then select Printer Tools.
4. Click Printer Scan Settings, then select the Picture tab.
5. Select Automatically Detect Pictures, if it is not selected, then click X to close the Printer Scan Settings.
6. Select Scan Documents and Pictures on the main screen of Home Center Software.
7. Make sure that Picture is selected and Collage - Combine all pictures is cleared, then follow the on-screen instructions.

NOTE: Click the Help (?) icon in Home Center Software for more information.

Scanning multiple pictures when connected to a computer with MAC OS

1. Lift the scanner lid, and place the pictures face down on the glass, leaving space between the pictures.
2. Close the lid.
3. Open Home Center Software, then select your printer.
4. Select the Tools tab.
5. Click Scan Application.
6. Select Color Picture or Black and White Picture.
7. Select Automatically detect multiple pictures, if it is not selected.
8. Click Preview or Scan All, then follow the on-screen instructions.

NOTE: Click the Help (?) icon for more information.
Maintaining Your Printer

Your printer requires little maintenance. However, Kodak recommends cleaning the scanner glass and lid regularly to remove dust and fingerprints, which affect the quality and accuracy of scanning and copying.

Except while cleaning the printer, keep the printer plugged into an AC power outlet. If you use a power strip, don’t turn off the power strip. (The printer does not need to be turned on but should be plugged in.)

Keep the printhead and ink cartridges in the printer at all times to help prevent damage to the printhead.

For recycling and/or disposal information, contact your local authorities. In the US, go to the Electronics Industry Alliance at www.eia.org or go to www.kodak.com/go/recycle.

General care and cleaning

⚠️ CAUTION:
Always disconnect the power to the printer before cleaning it. Do not use harsh or abrasive cleaners on any part of the printer.

- To clean the printer, wipe the outside with a clean, dry cloth.
- Keep the surrounding area vacuumed and litter-free.
- Protect the printer from tobacco smoke, dust, and liquid spills.
- Do not place objects on the printer.
- Keep the paper trays free of dust, dirt, and other foreign objects.
- Keep the printer supplies away from direct sunlight and out of high-temperature environments.
- Do not allow chemicals to come into contact with the printer.
Cleaning the scanner glass and document backing

The scanner glass can get smudged and minor debris can accumulate on the document backing under the scanner lid. Periodically clean the scanner glass and document backing.

⚠️ CAUTION:
Do not use harsh or abrasive cleaners on any part of the printer.
Do not spray liquid directly on the glass.
Do not use paper-based wipes on the document backing as they can scratch it.

1. Turn off the printer and unplug it from the power outlet.
2. Lift the scanner lid.
3. Wipe the glass with a soft cloth or sponge, slightly moistened with a nonabrasive glass cleaner.

4. Dry the glass with a lint-free cloth.

5. Gently clean the document backing with a soft cloth or sponge, slightly moistened with mild soap and warm water.

6. Dry the document backing with a chamois or lint-free cloth.
   
   NOTE: If the document backing needs further cleaning, use isopropyl (rubbing) alcohol on a soft cloth, then wipe thoroughly with a cloth moistened with water to remove any residual alcohol.

7. When you finish cleaning, plug in the printer.
Replacing ink cartridges

Your printer uses both black and color ink cartridges. You can check the approximate ink levels on the LCD (see Checking ink levels, page 100) or in Home Center Software. When an ink cartridge is out of ink, the printer LCD displays a message stating that the black or color ink cartridge needs replacing.

IMPORTANT: Do not use non-Kodak brand or refilled ink cartridges.

1. Make sure your printer is on.
2. Lift the access door, and wait for the carriage to move to the access position.

The ink cartridges are located in the printhead.
3. Pinch the tab on the ink cartridge.

4. Lift the ink cartridge out of the printhead.

5. Remove the new ink cartridge from its bag.

IMPORTANT: To prevent the printhead from drying out, insert the ink cartridge into the printhead immediately.
6. Remove the cap.

![Image of removing the cap](image1)

7. Insert the ink cartridge into the printhead.

![Image of inserting the ink cartridge](image2)

8. Press down on the ink cartridge tab until you hear a click.

![Image of pressing down on the ink cartridge tab](image3)

9. Close the access door.
Recovering the printhead

IMPORTANT: Replacing the printhead is not a regular maintenance procedure. Replace the printhead only if you receive a new printhead from Kodak.

1. Make sure your printer is on.
2. Lift the access door, and wait for the carriage to move to the access position.

3. Remove both ink cartridges and set them aside.
4. Unlatch the printhead by pushing the button in the center of the carriage.

5. Lift the printhead out of the carriage.

6. Remove the new printhead from its bag.
7. Remove the protective cap from the new printhead.

8. Install the printhead into the carriage.

9. Push firmly against the target label of the printhead until you hear a loud snap.
10. Insert the black ink cartridge into the printhead.

11. Press down on the ink cartridge until you hear a click.

12. Repeat steps 10 - 11 for the color ink cartridge.

13. Close the access door.
   The printer detects the new printhead. Follow the instructions on the control panel to calibrate your printer.
Updating the software and printer firmware

Using the latest software and firmware helps ensure optimal performance of your printer.

NOTE: Firmware is the software that runs on your printer.

Although there is an automatic background check for software and firmware updates when your computer is connected to the Internet, you can update manually using the following procedure.

Updating if your printer is connected to a computer with WINDOWS OS

To update the software:

1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software, then select Printer Tools.
   NOTE: If you do not have Home Center Software, select Start > All Programs > Kodak > KODAK AiO Printer Tools.
3. Under Printer Resources, click Check for Software Updates.
4. If there are updates, click Next and follow the on-screen instructions.

To update the firmware:

1. Make sure that your computer is connected to the Internet.
2. Connect the printer to the computer with a USB cable or wirelessly (if not currently connected).
3. Open Home Center Software, then select Printer Tools.
4. Make sure that your printer name appears in the lower left corner of the Printer Tools window followed by Connected.
   NOTE: If the printer name does not appear, click Select, then click Refresh List and choose your printer from the list; click OK and follow the on-screen instructions.
5. Under Printer Resources, click Check for Printer (Firmware) Updates.
6. If there are updates, click Next and follow the on-screen instructions.

IMPORTANT: Do not turn off or disconnect your printer or your computer during the update. Doing so may cause the printer to become inoperable. If the printer is connected wirelessly, make sure you have a stable connection when you perform the update. During the upgrade, your printer will restart. Wait for the message, “Update complete! You may now use your Kodak Printer” to appear on your computer.
Maintaining Your Printer

Updating if your printer is connected to a computer with MAC OS

To update the software:
1. Make sure that your computer is connected to the Internet.
2. Open Home Center Software.
3. Select the Tools tab.
4. Click Check for Software Updates.
5. If there are updates, follow the on-screen instructions.

To update the firmware:
1. Make sure that your computer is connected to the Internet.
2. Connect the printer to the computer with a USB cable or wirelessly (if not currently connected).
3. Open Home Center Software.
4. Select the Tools tab.
5. Click Check for Printer (Firmware) Updates.
6. If there are updates, follow the on-screen instructions.

IMPORTANT: Do not turn off or unplug your printer or your computer during the update. Doing so may cause the printer to become inoperable. Your printer will restart during the upgrade.

Checking ink levels
1. Press .
2. Touch , then Maintenance.
3. With Check Ink Levels selected, press.
   The LCD shows approximate levels of ink in the cartridges so you know when it’s time to order replacement cartridges.
   NOTE: You can order ink cartridges online. Go to www.kodak.com/go/printingsupplies.

Resetting factory defaults
1. Press .
2. Touch , then Printer Settings.
3. Touch , then Reset All Settings.
4. When you see the message, “This will reset printer settings to factory defaults. Continue?,” touch Yes.
   NOTE: Resetting factory defaults does not change the date and time, language, country/region, or network settings.
## 10 Troubleshooting

### Basic troubleshooting

If you experience a problem with your printer, restarting it will sometimes fix the issue. Turn off your printer, wait five seconds, then turn on your printer.

If you are still experiencing a problem, use the following information to troubleshoot your printer.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printer does not power on</td>
<td>• Make sure you are using the power cord that came with your printer.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the power cord is connected to the AC adapter, it is plugged into an outlet or power strip, and that the LED on the AC adapter is lit.</td>
</tr>
<tr>
<td></td>
<td>• Make sure that the power cord is securely connected to the power cord port in the back of the printer.</td>
</tr>
<tr>
<td>Printer not detected</td>
<td>• Make sure your printer is plugged in and turned on.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a USB cable, make sure that:</td>
</tr>
<tr>
<td></td>
<td>- it is a USB 2.0 high-speed cable.</td>
</tr>
<tr>
<td></td>
<td>- it is connected to both your printer and your computer.</td>
</tr>
<tr>
<td></td>
<td>- you restart the computer if the USB cable was disconnected from the printer then reconnected, or if power to the printer was interrupted.</td>
</tr>
<tr>
<td></td>
<td>• If you are using a wireless connection, make sure that:</td>
</tr>
<tr>
<td></td>
<td>- the Wi-Fi connectivity LED on the printer is glowing steadily.</td>
</tr>
<tr>
<td></td>
<td>- the printer is connected to your wireless network.</td>
</tr>
<tr>
<td></td>
<td>To check:</td>
</tr>
<tr>
<td></td>
<td>a. On the printer, press ( \text{Esc} ).</td>
</tr>
<tr>
<td></td>
<td>b. Touch ( \uparrow ), then <strong>Network Settings</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Touch <strong>View Network Configuration</strong>.</td>
</tr>
<tr>
<td></td>
<td>Make sure that the Active Connection Type is Wi-Fi, and that the IP Address is not 0.0.0.0.</td>
</tr>
<tr>
<td></td>
<td>- your router is transmitting data.</td>
</tr>
<tr>
<td></td>
<td>- the firewall (excluding WINDOWS Firewall) is allowing the services needed for your printer.</td>
</tr>
<tr>
<td></td>
<td>For more information, go to <a href="http://www.kodak.com/go/inkjetnetworking">www.kodak.com/go/inkjetnetworking</a>.</td>
</tr>
<tr>
<td>Carriage jam</td>
<td>• Open the access door and clear any obstructions.</td>
</tr>
<tr>
<td></td>
<td>• Make sure the printhead and ink cartridges are installed correctly.</td>
</tr>
<tr>
<td></td>
<td>(The printhead and ink cartridges are installed correctly when you hear them click into place.)</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Solutions</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Print quality                 | • For best results, use paper with the COLORLOK Technology logo on the package.  
                                 | • Make sure the paper is loaded correctly. See [Loading paper, page 43](#).  
                                 | • Clean the printhead:  
                                 |   - Press \( \text{Home} \).  
                                 |   - Touch \( \) , then **Maintenance**.  
                                 |   - Touch **Clean Printhead**.  
                                 | • Calibrate the printer:  
                                 |   - Press \( \text{Home} \).  
                                 |   - Touch \( \) , then **Maintenance**.  
                                 |   - Touch **Calibrate Printer**.  
                                 | • For more information, go to [www.kodak.com/go/esp3_2support](http://www.kodak.com/go/esp3_2support) (for ESP 3.2 Printers) or [www.kodak.com/go/esp3_2ssupport](http://www.kodak.com/go/esp3_2ssupport) (for ESP 3.2s Printers), then type the problem in the search field. |
| Ink cartridge                 | • Make sure KODAK Ink Cartridge(s) are installed. Do not use non-Kodak brand or refilled ink cartridges.  
                                 | • Remove, then install the cartridges again. Make sure the cartridges click into place.                                                                 |
| Paper jam                     | • Open the access door and gently remove any paper from inside the printer.  
                                 | • Make sure the paper in the tray is free of tears or creases.  
                                 | • Make sure you do not overload the paper input tray.  
                                 | For more information, go to [www.kodak.com/go/esp3_2support](http://www.kodak.com/go/esp3_2support) (for ESP 3.2 Printers) or [www.kodak.com/go/esp3_2ssupport](http://www.kodak.com/go/esp3_2ssupport) (for ESP 3.2s Printers), then type **jam** in the search field. |
| Error codes/messages          | • Go to [www.kodak.com/go/esp3_2support](http://www.kodak.com/go/esp3_2support) (for ESP 3.2 Printers) or [www.kodak.com/go/esp3_2ssupport](http://www.kodak.com/go/esp3_2ssupport) (for ESP 3.2s Printers), then type your error code or message.  
                                 | or other problems you cannot resolve                                                                                                                      |
|                               | If you need to contact Kodak (see [www.kodak.com/go/contact](http://www.kodak.com/go/contact)), have the following information available:  
                                 | • Kodak Service Number (located inside the printer when you open the access door)  
                                 | • Printer model number (located on the control panel)  
                                 | • Computer model, operating system, and version of Home Center Software  
                                 | • Exact wording of any error message(s) and the error code                                                                                               |
Getting help on the Web

For more troubleshooting information:

<table>
<thead>
<tr>
<th>Get help with wireless networking.</th>
<th><a href="http://www.kodak.com/go/inkjetnetworking">www.kodak.com/go/inkjetnetworking</a></th>
</tr>
</thead>
</table>
| Search our knowledge base of Questions and Answers. | www.kodak.com/go/esp3_2support (for ESP 3.2 Printers)  
www.kodak.com/go/esp3_2ssupport (for ESP 3.2s Printers) |
| Download the latest firmware and software for optimal printer performance. | www.kodak.com/go/esp3_2downloads (for ESP 3.2 Printers)  
www.kodak.com/go/esp3_2sdownloads (for ESP 3.2s Printers) |
| Get help with problems you cannot resolve. | Contact Kodak at www.kodak.com/go/contact and have the following information available:  
  - Kodak Service Number (located inside the printer when you open the access door)  
  - Printer model number (located on the control panel)  
  - Computer model, operating system, and version of Home Center Software |
Status lights

The status lights indicate the condition of the printer. There are two status lights on the printer: one on the on/off button that indicates power, the other indicates Wi-Fi status.

Power light

<table>
<thead>
<tr>
<th>Power light</th>
<th>What it means</th>
</tr>
</thead>
</table>
| Off         | The printer is turned off.  
               • Press the power button to turn on power.  
               • The printer does not have power.  
               • Make sure that the power cord is plugged into the back of the printer and into an electrical outlet, and that the electrical outlet has power. |
| Blinking    | The printer is busy.  
               • Wait for the printer to finish the task. |
| On          | The printer is ready. |

Wi-Fi connectivity LED

<table>
<thead>
<tr>
<th>Wi-Fi connectivity LED</th>
<th>What it means</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The Wi-Fi radio is either turned off or is turned on but not connected to a wireless network.</td>
</tr>
<tr>
<td>Blinks continuously</td>
<td>The Wi-Fi radio is turned on, and the printer is searching for available wireless networks within range.</td>
</tr>
</tbody>
</table>
| Blinks intermittently  | The Wi-Fi radio is turned on and the printer cannot find any available wireless networks within range, or the Wi-Fi radio connection has been interrupted, or is too weak to send signals to and from the printer.  
To find and connect to an available wireless network within range, touch **OK**, turn the Wi-Fi radio off, and run the Wi-Fi Setup Wizard (see Connecting to a wireless network, page 9). |
| On                     | The Wi-Fi radio is turned on, and there is a working connection between the printer and a wireless network. |
11  Product and Safety Specifications

The following specifications are subject to change without notice.

Specifications and features

Print performance

- **Black print speed**: 8 images per minute
- **Color print speed**: 5.5 images per minute
- **Print technology**: Continuous-tone, thermal inkjet
- **Print quality modes**: Draft, Normal, and Best on plain paper
  - Best on photo paper

Photo printing features

- **Quantity**: 1 to 99
- **Print sizes**: 2 x 3 in. / 5 x 8 cm
  - 3.5 x 5 in. / 9 x 13 cm
  - 4 x 6 in. / 10 x 15 cm
  - 4 x 7 in. / 10 x 18 cm
  - 4 x 8 in. / 10 x 20 cm
  - 4 x 12 in. / 10 x 30 cm (Panoramic)
  - 5 x 7 in. / 13 x 18 cm
  - 8 x 10 in. / 20 x 25 cm
  - US Letter - 8.5 x 11 in. / 22 x 28 cm
  - A4 - 8.3 x 11.7 in. / 21 x 30 cm
- **Quality**: Best, Normal, Draft modes on plain paper
  - Best on photo paper (automatically selected)
- **Auto-detect media**: Auto-detect plain paper and photo papers
- **Image enhancement**: Optimize image quality for KODAK Photo Papers with barcode
- **Image enhancement**: KODAK PERFECT TOUCH Technology with Home Center Software
- **Add date to prints**: No (default), Yes
- **Color**: Black and white or color
- **Scene balance**: On (default), Off

Copy document features

- **Color**: Black and white or color
- **Quantity**: 1 to 99 copies
- **Copy sizes**: Same Size, Fit-to-Page, 20 to 500%
- **Plain paper quality**: Best, Normal, Draft
- **Brightness**: −3 to + 3
Copy photo features

- **Color**: Black and white or color
- **Quantity**: 1 to 99 copies
- **Copy sizes**:
  - 2 x 3 in. / 5 x 8 cm
  - 3.5 x 5 in. / 9 x 13 cm
  - 4 x 6 in. / 10 x 15 cm
  - 4 x 7 in. / 10 x 18 cm
  - 4 x 8 in. / 10 x 20 cm
  - 4 x 12 in. / 10 x 30 cm (Panoramic)
  - 5 x 7 in. / 13 x 18 cm
  - 8 x 10 in. / 20 x 25 cm
  - US Letter - 8.5 x 11 in. / 22 x 28 cm
  - A4 - 8.3 x 11.7 in. / 21 x 30 cm
- **Quality**: Automatic
- **Brightness**: −3 to + 3

Scanning features

- **Scanner type**: Contact Image Sensor (CIS)
- **Maximum scan size**: 8.5 x 11.7 in. / 22 x 30 cm
- **Resolution and Bit Depth**:
  - Supports native scan resolution of 2400 dpi
  - Scans at 8 bits per channel, with 3-color scans at 24 bits/pixel
- **Functions**:
  - Segmentation scanning
  - Auto-destination
  - OCR
  - Auto picture detection

Paper input tray features

- **Paper capacity**:
  - 100 sheets of 20 lb plain paper
  - 20 sheets of photo paper, up to 12 mil (290 gsm)
  - 20 envelopes
- **Tray size**:
  - 4 x 6 in. to 8.5 x 14 in. / 10 x 15 cm to 22 x 36 cm
Paper types supported

- **Plain paper**: 16 to 24 lb (60 to 90 gsm)
- **Photo paper**: Up to 12 mil (290 gsm)
- **Card stock**: 110 lb index max (200 gsm)
- **Envelopes**: 20 to 24 lb (75 to 90 gsm)
- **Labels**: All commercially available inkjet varieties on 8.5 x 11 in. and A4 size sheets
- **Iron-on transfers**: All commercially available inkjet varieties on 8.5 x 11 in. and A4 size sheets

Paper sizes supported

- **Plain paper**
  - A4 (8.3 x 11.7 in. / 21 x 30 cm)
  - A5 (5.8 x 8.3 in. / 15 x 21 cm.)
  - A6 (4.1 x 5.8 in. / 11 x 15 cm)
  - B5 (6.9 x 9.8 in. / 18 x 25 cm)
  - US Executive (7.3 x 10.5 in. / 18 x 27 cm)
  - US Letter (8.5 x 11 in. / 22 x 28 cm)
  - US Legal (8.5 x 14 in. / 22 x 36 cm)
  - Custom sizes from 4 to 8.5 in. / 10 to 22 cm wide and 6 to 14 in. / 15 to 36 cm long
- **Labels**
  - A4 (8.3 x 11.7 in. / 21 x 30 cm)
  - US Letter (8.5 x 11 in. / 22 x 28 cm)
- **Index card stock**
  - 4 x 6 in. / 10 x 15 cm cards
  - 5 x 7 in. / 13 x 18 cm index cards
- **Iron-on transfers**
  - A4 (8.3 x 11.7 in. / 21 x 30 cm)
  - US Letter (8.5 x 11 in. / 22 x 28 cm)
- **Envelopes**
  - C5 (6.7 x 9 in. / 16 x 23 cm)
  - C6 (4.5 x 6.4 in. / 11 x 16 cm)
  - DL (designated long) (11 x 22 cm / 4.3 x 8.7 in.)
  - US #7¼ (3.9 x 7.5 in. / 10 x 19 cm)
  - US #9 (3.9 x 8.9 in. / 10 x 23 cm)
  - US #10 (4.1 x 9.5 in / 10.5 x 24 cm)
Photos

4 x 6 in. / 10 x 15 cm
4 x 7 in. / 10 x 18 cm
4 x 8 in. / 10 x 20 cm
4 x 12 in. / 10 x 31 cm
5 x 7 in. / 13 x 18 cm
7 x 10 in. / 18 x 25 cm
8 x 10 in. / 20 x 25 cm
US Letter (8.5 x 11 in. / 22 x 28 cm)
A4 (8.3 x 11.7 in. / 21 x 30 cm)

Ink cartridges

Ink handling 2-cartridge, 4-ink system
Ink life 1-year warranty from date of purchase

Connectivity

Protocols supported USB 2.0 High Speed; DPOF
Devices supported WINDOWS OS-based and MACINTOSH Computers, memory cards (SD, MS/Duo, MMC, SDHC)
Image Formats supported Image printing supports JPEG (EXIF v2.2); does not support progressive JPEG format
Protocols supported USB 2.0 High Speed (for connection to computer only), DPOF (Tagged image printing)
Wi-Fi Technology supported 802.11b/g/n, WPA/WPA2, and WPS

Software support

Application support Third-party image management applications; optical character reader (OCR) support for documents
Media support Plain paper, photo paper, envelopes, greeting cards, labels, and iron-on transfers
Scanner support TWAIN and WIA, WIA2 (VISTA OS and WINDOWS 7), ICA (MAC OS), including segmentation scanning
Update support Software and firmware updates available through Web support
Physical specifications

**Power**

Input: 100–240 V AC, 50–60 Hz
The printer should only be used with a switching adapter.
Manufacturer and model:
Asia Power Devices Inc., Model DA-18A36
Chicony Power Technology Co., Ltd, Model A10-018N3A

**Operating Dimensions**

16.9 in. (43.0 cm) long x 19.8 in. (50.3 cm) wide x 12.0 in. (30.5 cm)

**Weight**

12.7 lb (5.8 kg) with power supply, printhead, and ink cartridges

**Operating range**

41 to 95°F (5 to 35°C), 15 to 85% RH

**Full image quality environmental range**

59 to 86°F (15 to 30°C), and 20 to 80% RH.

**Energy efficiency**

ENERGY STAR® Qualified All-in-One Printer

Warranty

**Printer**

One year from purchase (with proof of purchase)

**Printhead**

One year from purchase (with proof of purchase)

System requirements

**Computer with WINDOWS OS**

**Minimum**

**Operating system**

WINDOWS 7, VISTA, or XP (SP2 or later)

**CPU**

INTEL CELERON Processor

**Clock speed**

1.2 GHz

**Memory**

512 MB RAM

**Available hard disk space**

500 MB available

**Interface**

USB 2.0 High Speed

**Removable drive**

CD-ROM
# Computer with MAC OS

<table>
<thead>
<tr>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating system</strong></td>
</tr>
<tr>
<td>MAC OS X 10.5 or later</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
</tr>
<tr>
<td>PowerPC G4, G5, or INTEL-based MAC</td>
</tr>
<tr>
<td><strong>Clock speed</strong></td>
</tr>
<tr>
<td>1.2 GHz</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
</tr>
<tr>
<td>512 MB RAM</td>
</tr>
<tr>
<td><strong>Available hard disk space</strong></td>
</tr>
<tr>
<td>200 MB available</td>
</tr>
<tr>
<td><strong>Interface</strong></td>
</tr>
<tr>
<td>USB 2.0 High Speed</td>
</tr>
<tr>
<td><strong>Removable drive</strong></td>
</tr>
<tr>
<td>CD-ROM</td>
</tr>
</tbody>
</table>
Safety information

KODAK ESP 3.2 All-in-One Printers are Class 1 LED Products.

- Always follow all warnings and instructions marked on the product.
- Use only the power source provided with the product.
- Use only the power cord that comes with the product (or an approved power cord greater or equal to H05W-F, 2G, 0.75mm²). Using another power cord may cause fire and/or shock. Do not use the included power cord with any other equipment.
- If you do not use this product for a long period of time, unplug it from the electrical outlet.
- Always turn this product off by using the On/Off button. Wait until the On/Off button stops flashing before removing the power plug from the outlet.
- Do not allow the power cord to become damaged or frayed.
- If you need to use an extension cord with this product, make sure that the ampere rating of the product does not exceed the ampere rating of the extension cord.
- Place the product on a flat, stable surface that extends beyond the product’s base in all directions. This product will not operate properly if tilted or at an angle.
- When storing or transporting this product, do not tilt or stand it on its side. Never turn this product upside down (ink can leak out of the product).
- Avoid placing this product in an environment that is subject to rapid changes in temperature or humidity, mechanical shocks, vibration, or dust. Do not place near radiators, heating vents, or in direct sunlight.
- Leave enough room around this product for sufficient ventilation.
- Do not block this product’s covers or openings, or insert any objects through slots.
- Do not use aerosol products inside or around this product.
- Do not spill any liquid on this product.
- Do not attempt to repair or service this product.
- If the power cord or plug is damaged, if any liquid has been spilled onto the product, if the product has been dropped or the case damaged, if the product does not operate normally or exhibits a major change in performance level, unplug this product and contact Kodak at www.kodak.com/go/contact.
**LCD screen safety**

- Use only a dry, soft cloth to clean the LCD screen. Do not use any liquid or chemical cleaners.
- If the LCD screen is damaged, contact Kodak immediately. If any of the solution from the display gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush your eyes immediately with water. If any discomfort or change in vision persists after washing, seek medical attention immediately.

**Ink cartridge safety**

- Keep all ink cartridges out of the reach of children.
- If ink gets on your skin, wash with soap and water. If ink gets into your eyes, flush immediately with water. If any discomfort or change in vision persists after washing, seek medical attention immediately.
- For Material Safety Data Sheets (MSDS) information on inks, go to [www.kodak.com/go/MSDS](http://www.kodak.com/go/MSDS).

NOTE: You will need the Catalog number from the ink package.
Regulatory compliance

FCC statement

The United States Federal Communications Commission (in CFR 47 Part 15.105) has specified that the following notice be brought to the attention of the users of this product:

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the product into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

CAUTION:

Pursuant to Part 15.21 of the FCC Rules, any changes or modifications to this product not expressly approved by Eastman Kodak Company might cause harmful interference and void the FCC authorization to operate this product.

The radiated energy from this product is well below the FCC radio frequency exposure limits. Nevertheless, the product shall be used in such a manner that the potential for human contact during normal operation is minimized. This product and any attached external antenna, if supported, shall be placed in such a manner to minimize the potential for human contact during normal operation. In order to avoid the possibility of exceeding the FCC exposure limits, human proximity shall not be less than 20 cm (8 inches) during normal operation.
Canadian statements

This product meets the applicable Industry Canada technical specifications.

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this device must accept any interference, including interference that may cause undesired operation of the device.

This Class B digital apparatus complies with Canadian ICES-003.

Industry Canada (IC) Radiation Exposure Statement

This equipment complies with IC radiation exposure limits set forth for an uncontrolled environment. This equipment should be installed and operated with a minimum distance of 20 cm between the radiator and your person.

European compliance statement

Hereby, Kodak declares that this wireless KODAK All-in-One Printer is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/EC.

German compliance statement

⚠️ CAUTION:
This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommoding reflections at visual display workplaces this device must not be placed in the direct field of view.

⚠️ CAUTION:
Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht im unmittelbaren Gesichtsfeld platziert werden.

Noise emissions for this equipment do not exceed 70 dBA.

This equipment is not intended for use in the workplace in accordance with BildscharbV regulations.

“Das Gerät ist nicht für die Benutzung am Bildschirmarbeitsplatz gemäß BildscharbV vorgesehen.”
REACH Article 33 declarations

Go to www.kodak.com/go/REACH for information about the presence of substances included on the candidate list according to article 59(1) of Regulation (EC) No. 1907/2006 (REACH).

Waste electrical and electronic equipment labeling

In the European Union, do not discard this product as unsorted municipal waste. Contact your local authorities or go to www.kodak.com/go/recycle for recycling program information.

ENERGY STAR® Qualified All-in-One Printer

To conserve energy, this printer will enter a reduced power (sleep) mode automatically after 1 hour. You can adjust the delay time (in 0.5 hour increments) up to 4 hours. Increasing the delay time may result in reduced energy savings.

ENERGY STAR and the ENERGY STAR mark are registered U.S. service marks. As an ENERGY STAR partner, Kodak has determined that this product meets ENERGY STAR Guidelines for energy efficiency. For more information on the ENERGY STAR program, see www.energystar.gov.
Warranty Information

Limited Warranty

Kodak warrants Kodak consumer electronic products and accessories ("Products"), excluding batteries, to be free from malfunctions and defects in both materials and workmanship for one year from the date of purchase. Retain the original dated sales receipt. Proof of the date of purchase will be required with any request for warranty repair.

Limited Warranty Coverage

Warranty service is only available from within the country where the Products were originally purchased. You may be required to send Products, at your expense, to the authorized service facility for the country where the Products were purchased. Kodak will repair or replace Products if they fail to function properly during the warranty period, subject to any conditions and/or limitations stated herein. Warranty service will include all labor as well as any necessary adjustments and/or replacement parts. If Kodak is unable to repair or replace a Product, Kodak will, at its option, refund the purchase price paid for the Product provided the Product has been returned to Kodak together with proof of the purchase price paid. Repair, replacement, or refund of the purchase price are the sole remedies under this warranty. If replacement parts are used in making repairs, those parts may be remanufactured or may contain remanufactured materials. If it is necessary to replace the entire Product, it may be replaced with a remanufactured Product. Remanufactured Products, parts and materials are warranted for the remaining warranty term of the original Product, or 90 days after the date of repair or replacement, whichever is longer.

Limitations

This warranty does not cover circumstances beyond Kodak’s control. This warranty does not apply when failure is due to shipping damage, accident, alteration, modification, unauthorized service, misuse, abuse, use with incompatible accessories or attachments (such as third party ink or ink tanks), failure to follow Kodak’s operation, maintenance or repacking instructions, failure to use items supplied by Kodak (such as adapters and cables), or claims made after the duration of this warranty. KODAK MAKES NO OTHER EXPRESS OR IMPLIED WARRANTY FOR THIS PRODUCT, AND DISCLAIMS THE IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. In the event that the exclusion of any implied warranty is ineffective under the law, the duration of the implied warranty will be one year from the purchase date or such longer period as required by law. The option of repair, replacement, or refund is Kodak’s only obligation. Kodak will not be responsible for any special, consequential or incidental damages resulting from the sale, purchase, or use of this product regardless of the cause. Liability for any special consequential or incidental damages (including but not limited to loss of revenue or profit, downtime costs, loss of the use of the equipment, cost of substitute equipment, facilities or services or claims of your customers for such damages resulting from the purchase, use or failure of the Product), regardless of cause, or for breach of any written or implied warranty is expressly disclaimed.

Your Rights

Some states or jurisdictions do not allow exclusion or limitation of incidental or consequential damages, so the above limitation or exclusion may not apply to you. Some states or jurisdictions do not allow limitations on how long an implied warranty lasts, so the above limitation may not apply to you. This warranty gives you specific rights, and you may have other rights which vary from state to state or by jurisdiction. Your statutory rights are not affected.

Outside the United States and Canada

In countries other than the United States and Canada, the terms and conditions of this warranty may be different. Unless a specific Kodak warranty is communicated to the purchaser in writing by a Kodak company, no warranty or liability exists beyond any minimum requirements imposed by law, even though defect, damage, or loss may be by negligence or other act.
Declaration of Conformity

See www.kodak.com/go/declarationofconformity.